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Introduction
This guide explains the installation, deployment, and administration of Siebel 
application clients.

Siebel Mobile Web Client and Siebel Dedicated Web Client installation are covered, 
as is browser deployment for Siebel Web Client, Mobile Web Client and Dedicated 
Web Client.

Although job titles and duties at your company may differ from those listed in the 
following table, the audience for this guide consists primarily of employees in these 
categories:

Product Modules and Options
This Siebel Bookshelf contains descriptions of modules that are optional and for 
which you may not have purchased a license. Siebel’s Sample Database also 
includes data related to these optional modules. As a result, your software 
implementation may differ from descriptions in this Bookshelf. To find out more 
about the modules your organization has purchased, see your corporate purchasing 
agent or your Siebel sales representative.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel products. 

Siebel Application 
Developers

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Installers Persons responsible for setting up Siebel systems for initial use.
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How This Guide Is Organized
How This Guide Is Organized
This guide provides information necessary to install and configure Siebel clients, 
organized according to the types of Siebel clients you may deploy.

■ The overview applies to all major Siebel clients. 

■ Installation instructions apply to those who install the Mobile and Dedicated 
Web Clients. 

■ Deployment instructions apply to those who deploy Web browsers and Siebel 
Web Client, Mobile Web Client, or Dedicated Web Client.

■ Mobile Web Client configuration and usage information applies to those who 
perform administration tasks to support mobile users and Siebel Remote.

■ Configuration parameter information applies to those who will modify 
configuration files for Mobile and Dedicated Web Clients.

■ Siebel Packager information applies to those who create installer packages for 
Mobile and Dedicated Web Clients.
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Additional Resources
Additional Resources
For additional information on topics related to those covered in this book, see the 
following books:

■ Siebel Server Installation Guide for the operating system you are using, for 
information about server installation procedures.

■ Siebel Server Administration Guide, for information about managing Application 
Object Managers and the Siebel Web Client, and about managing configuration 
parameters for Siebel Server. 

■ Upgrade Guide for the operating system and database you are using, for 
information about upgrading Siebel eBusiness Applications.

■ Siebel Tools Reference, for information about installing the Siebel Tools Client 
and about configuring the Siebel application.

■ Siebel Remote and Replication Manager Administration Guide, for information 
about supporting Siebel Remote and the Mobile Web Client.

■ Security Guide for Siebel eBusiness Applications, for information about security 
issues for Siebel eBusiness Applications.

■ System Requirements and Supported Platforms, for information about platform 
and third-party software issues affecting your Siebel client deployment.
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Revision History
Revision History
Siebel Web Client Administration Guide

Version 7.5.3
Table 1. Changes Made in Version 7.5.3

Topic Revision

“User Rights for Running Siebel Client” on 
page 28

Added subsection.

“Siebel Mobile and Dedicated Web Client 
Startup Options” on page 50

Added caution about modifying default 
shortcuts.

“Uninstalling the Mobile and Dedicated 
Web Clients” on page 51

Added subsection about automated 
uninstallation.

Chapter 3, “Deploying Siebel Web Clients” Added new chapter about deploying Siebel 
Web clients in Web browser environment.

New for version 7.5.3: The ActiveX control 
based on the CAB file SiebelOptionPack.cab 
is new. It replaces the controls based on the 
CAB files Axhook.cab and setopt.cab, 
which were applicable to previous version 
7.5.x releases.

“User Synchronization Options for Mobile 
Web Client” on page 83

Updated descriptions and illustration of the 
Siebel Remote synchronization dialog box.

Chapter 5, “Using Siebel Packager Utility” Moved former Appendix B to become 
Chapter 5. 

“Customizing Siebel.ini Files” on page 105 Revised for version 7.5.3: Updated 
description of the RootDirectory 
parameter, for the siebel.ini file.

Added description of the addLanguages 
parameter, for the siebel.ini file.
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Revision History
“Configuration Parameters Index” on 
page 117

New for version 7.5.3: Added Siebel 
Bookshelf references for the following 
parameters, which are new in version 7.5.3:

■ AccessibleEnhanced

■ ApplicationStyle

■ CommConfigCache

■ ViewPreloadSize

■ WebTemplatesVersion

“Configuration Parameters Index” on 
page 117

Added Siebel Bookshelf references for the 
following configuration parameters, which 
were previously not listed in this book:

■ EditFieldCaption

■ EditFieldType

■ EnableCDA

■ ListRowStyle

■ MarkupLanguage

■ NumberOfBookmarks

■ NumberOfListRows

■ RequiredIndicator

■ ShowWriteRecord

■ SystemSWFName

■ TreeNodeX 

■ UserSWFName

■ UserSWSName

“Siebel Application Parameters for Client” 
on page 128

Updated description of the 
EncryptPassword parameter.

Table 1. Changes Made in Version 7.5.3

Topic Revision
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Revision History
January 2003 Bookshelf
Table 2. Changes Made in 7.5, Rev. A for January 2003 Bookshelf

Topic Revision

“Configuring the Siebel Application” on 
page 23

New section.

“Application Names and Siebel Clients” on 
page 24

New section.

“User Preferences and Siebel Clients” on 
page 25

New section.

“Other Third-Party Software” on page 31 Removed non-required third-party software.

“Installing the Siebel Mobile and Dedicated 
Web Client” on page 32

Consolidated and updated installation 
procedures for Mobile and Dedicated Web 
Clients.

“Siebel Client ODBC Data Sources” on 
page 45

Updated list of ODBC data sources.

“Siebel Client Shortcuts” on page 46 Updated lists of shortcuts (icons).

“Logging into Your Siebel Application” on 
page 48

Updated to cover all major client types. 
Moved section from later chapter.

“Siebel Mobile and Dedicated Web Client 
Startup Options” on page 50

New section.

“Siebel Mobile Web Client and Siebel 
QuickStart” on page 91

Updated section. Moved section from earlier 
chapter.

“Editing Configuration Files” on page 116 Moved section from earlier chapter.

“Configuration Parameters Index” on 
page 117

Merged from previously separate appendix 
and updated.

“Siebel Application Parameters for Client” 
on page 128

Updated list of parameters for [Siebel] 
section.

“Data Source Parameters” on page 134 Updated list of parameters for data source 
sections.
12 Siebel Web Client Administration Guide Version 7.5.3



Introduction

Revision History
Additional Changes

■ This document now refers to the Siebel client installation directory, such as 
C:\sea752\client, as SIEBEL_CLIENT_ROOT.

“Product Configurator Parameters” 
(and following subsections)

Removed sections on module-specific 
parameters. Added references in 
configuration parameters index.

“Sample Selection from Configuration File” 
on page 144

Moved section from earlier chapter.

Table 2. Changes Made in 7.5, Rev. A for January 2003 Bookshelf

Topic Revision
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About Siebel Clients 1
This chapter provides general information about the following Siebel application 
client types:

■ Siebel Web Client

■ Siebel Mobile Web Client

■ Siebel Dedicated Web Client

A Siebel client is a computer that operates Siebel eBusiness Applications, accessing 
data and services by way of one or more servers. The Siebel clients allow users to 
access information managed by Siebel applications. All Siebel deployments include 
one or more of the Siebel client types. You can deploy a mixture of clients.
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About Siebel Clients
Figure 1 shows the major Siebel client types, in a deployment that includes multiple 
Siebel Servers. Following the illustration are descriptions of these clients.

Figure 1. Architecture of a Siebel Client Deployment
16 Siebel Web Client Administration Guide Version 7.5.3



About Siebel Clients

Siebel Client Types
Siebel Client Types
The following types of Siebel eBusiness Applications clients are discussed in this 
book:

■ Siebel Web Client. Siebel Web Client runs in a standard browser on the end user’s 
client computer, and does not require any additional persistent software 
installed on the client. The browser connects through a Web server to the Siebel 
Server, which executes business logic and accesses data from the Siebel 
Database. Only the user interface layer of the Siebel eBusiness Applications 
architecture resides on the user computer. 

For more information, see “Siebel Web Client” on page 18.

■ Siebel Mobile Web Client. Siebel Mobile Web Client is designed for local data 
access, without the need to be connected to a server. Each mobile machine 
includes a local database, which the mobile user periodically synchronizes with 
the Siebel (enterprise) database. The Mobile Web Client runs in a standard 
browser on the end user’s client computer, such as a laptop, but does not 
connect to a Web server. All layers of the Siebel eBusiness Applications 
architecture reside on the user computer.

For more information, see “Siebel Mobile and Dedicated Web Clients” on 
page 20.

■ Siebel Dedicated Web Client. Siebel Dedicated Web Client connects directly to a 
database server for all data access, and does not store any Siebel data locally. 
The Dedicated Web Client runs in a standard browser on the end user’s client 
computer, but does not connect to a Web server. All layers of the Siebel 
eBusiness Applications architecture, except for the database, reside on the user 
computer.

For more information, see “Siebel Mobile and Dedicated Web Clients” on 
page 20.

NOTE: Clients for Siebel Handheld and Siebel Wireless products are not discussed in 
this book. For more information, see applicable documents on Siebel Bookshelf.
Version 7.5.3 Siebel Web Client Administration Guide 17



About Siebel Clients

Siebel Web Client
The Siebel Web Client, Mobile Web Client, and Dedicated Web Client run in a third-
party Web browser. 

For information about Web browser deployment for Siebel applications, see 
Chapter 3, “Deploying Siebel Web Clients.” For supported browser versions, refer to 
System Requirements and Supported Platforms.

Comparing Siebel Clients
Table 3 compares the features of Siebel application clients. For more information, 
see “Siebel Web Client” on page 18 and “Siebel Mobile and Dedicated Web Clients” 
on page 20.

Siebel Web Client
Siebel Web Client is a true thin client—no application logic is stored on the client 
computer. Siebel Web Client provides these benefits to the deployment of your 
Siebel applications:

■ No Siebel software installation is required on the client computer.

■ No Siebel upgrades are required on the client computer.

Table 3. Deciding Which Siebel Client Meets Your Needs

Client Feature
Siebel Web 
Client

Siebel Mobile 
Web Client

Siebel Dedicated 
Web Client

Installation required; upgrade 
capabilities

X X

Self-contained: does not need a Web 
server

X X

Works on disconnected Windows client 
computer; able to synchronize

X

Network connectivity: direct connection 
to database

X X

Zero-footprint; no local installation X

UNIX platforms X
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Siebel Web Client
■ Central management and support reduces IT and deployment costs and supports 
a heterogeneous assortment of desktop computers.

Siebel Web Client and Application Object Manager
With the Siebel Web Client, the Application Object Manager on the Siebel Server 
hosts the Business Objects layer and Data Objects layer of the Siebel architecture. 
The Siebel Web Client hosts the User Interface layer of the Siebel architecture.

By hosting Siebel Business Objects and business logic processing on the server, the 
Application Object Manager supports:

■ Deployment of Siebel Web Client

■ Real-time integration with external applications through the Siebel Object 
Interfaces

■ Simplified administration

The Application Object Manager, running on Siebel Server, communicates with the 
Siebel Web Client through the Web server, using the TCP/IP protocol. 
Communication between the client and the Application Object Manager can be 
compressed and encrypted. An independent session is established to serve 
incoming connection requests from each client. Subsequent requests from clients 
are directed to the same Application Object Manager tasks until the sessions are 
terminated.

Siebel applications use session cookies to track the session state. For details, see 
“Using Cookies with Siebel Applications” on page 74.

The Siebel repository file (SRF) is installed as part of each Siebel Server installation, 
in the SIEBSRVR_ROOT\objects\LANGUAGE directory. Any changes to the 
repository file must be applied to all Siebel Server installations that are to serve the 
modified application to the Siebel Web Client. When reconnecting to the 
Application Object Manager, Web Client users automatically retrieve the new Siebel 
application configuration.

NOTE: You can deploy a copy of the same SRF file on Microsoft Windows or UNIX 
systems.
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Siebel Mobile and Dedicated Web Clients
Siebel Mobile and Dedicated Web Clients
The Siebel Mobile and Dedicated Web Clients contain user interface and business 
logic, and require installation of Siebel software on each users’s computer. Both of 
these Siebel clients are Microsoft Windows clients, delivered through a Web 
browser.

The software installed on the user’s machine for the Siebel Mobile Web Client and 
Dedicated Web Client is identical. However, the installer presents a subset of 
prompts if you are installing the Mobile Web Client. 

Once the Mobile Web Client has been installed, you can modify the configuration 
file to allow the client to connect to the enterprise database (functioning as a 
Dedicated Web Client) or to the local database (functioning as a Mobile Web 
Client). As installed, the Dedicated Web Client can connect to either database 
(functioning as either a Dedicated Web Client or a Mobile Web Client).

These Siebel clients include a lightweight HTTP listener that listens on a dynamic 
port for HTTP requests from the local machine. Any requests from other machines 
on the network are ignored. Therefore, minimal security risk exists when the 
application is used on the network.

■ Siebel Mobile Web Client. This client is designed for local data access and does not 
need to be connected to a server. Siebel Mobile Web Client meets the needs of 
field professionals who do not have continuous access to a network. Siebel 
Mobile Web Client uses a local database on each mobile machine.

Periodically, the client must access the Siebel Remote Server (on a Siebel Server) 
using a local area network (LAN), wide area network (WAN), virtual private 
network (VPN), or modem to synchronize data changes with the Siebel 
Database on the database server and with the Siebel File System.

NOTE: Siebel QuickStart is an agent that is preloaded on a mobile user’s machine 
at startup and reduces the time required to launch the Siebel Mobile Web Client. 
For more information, see “Siebel Mobile Web Client and Siebel QuickStart” on 
page 91.
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Siebel Mobile Web Client and Siebel Remote
■ Siebel Dedicated Web Client. This client provides direct connectivity to a database 
server. It requires software to be installed on the client machine, but does not 
require a local database, Web server, or Application Object Manager on a Siebel 
Server.

Some operations are performed only by Siebel Server components. Functionality 
associated with many Siebel modules requires Siebel Server. For example, batch 
operations such as those performed by Siebel Assignment Manager require a 
Siebel Server. For more information, consult the documentation for the Siebel 
modules you plan to use, and see Siebel Server Administration Guide.

NOTE: The Siebel Dedicated Web Client can connect to the Siebel File System in 
different ways. For more information, see the description of the FileSystem 
configuration parameter in “Data Source Parameters” on page 134.

Siebel Mobile Web Client and Siebel Remote
The Siebel Mobile Web Client is designed to operate without a real-time connection 
to any server.

The Mobile Web Client downloads a portion of the Siebel Database and the Siebel 
File System to the user’s computer, so that the user can access the data locally 
without being connected directly to the Siebel Database, Siebel Server, or Siebel File 
System. The Mobile Web Client then periodically accesses the Siebel Server using a 
LAN, WAN, VPN, or modem to synchronize data changes between the local 
database and the enterprise database.

For information about setting up Siebel Remote, see Siebel Remote and Replication 
Manager Administration Guide.

Local Database and File System
The Siebel Mobile Web Client uses a local database to store data for user access. 
The local database, based on SQL Anywhere, contains Siebel applications tables 
that store user data. 
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Siebel Mobile Web Client and Siebel Remote
Transactions created by the mobile user are stored in DX files. Siebel Remote 
forwards these transactions to the Siebel Remote Server when the client 
synchronizes. These log files (which accumulate in the SIEBEL_CLIENT_ROOT\log 
directory) can be deleted if necessary to conserve space. The most recent log files 
should be kept for troubleshooting and diagnostic purposes.

The Siebel Mobile Web Client also uses a local Siebel File System to store files from 
the Siebel File System for the Enterprise. These files are available when the user is 
disconnected from the Siebel Server. Users can request specific files to download to 
their local Siebel File System. The Siebel administrator can also specify files to be 
published or broadcast to all mobile users. Files added locally by the mobile user 
will be uploaded to the Siebel File System at the next synchronization session.

See also the description of the FileSystem configuration parameter described in 
“Data Source Parameters” on page 134.

Siebel Remote Client Software
The Siebel Remote client software runs on the Siebel Mobile Web Client and 
manages the synchronization process between the Mobile Web Client and the Siebel 
Remote Server. Mobile users can start the Siebel Remote client in two ways:

■ Background synchronization

While the Siebel client is running, mobile users can use the Synchronize 
command in the File menu to launch the Siebel Remote client as a background 
process. Work can continue within Siebel applications or other applications 
during the synchronization process.

■ Stand-alone synchronization

When the Siebel client is not running, mobile users can launch the Siebel 
Remote client in stand-alone synchronization mode, by using the Siebel Remote 
shortcut or a third-party scheduling program. During stand-alone 
synchronization, the Siebel Remote client synchronizes the local database 
separately from the Siebel client.

The Siebel client cannot be running during stand-alone synchronization.

The Siebel Remote client uses the TCP/IP protocol to communicate with the Siebel 
Remote Server using a LAN, WAN, VPN, or modem.
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Configuring the Siebel Application
Synchronization Process Overview
The synchronization process invoked by the Siebel Remote client includes the 
following stages:

1 Connects to the Siebel Remote Server, which starts a Synchronization Manager 
session for the Mobile Web Client. 

NOTE: The Synchronization Manager notifies the mobile user if the Siebel 
administrator has performed a database extract for the Mobile Web Client or if 
the local database does not exist.

2 Extracts transactions from the local database.

3 Sends and receives transaction files to and from Synchronization Manager.

4 Sends and retrieves file attachments.

5 Applies transaction files from the Siebel Remote Server to the local database.

6 Applies transaction files from the local database to the server database.

Configuring the Siebel Application
The user interface of the Siebel application, as delivered through the Web browser 
and the Siebel client, is made up of many interrelated elements. You configure many 
of these elements or their behavior by using Siebel Tools to modify Siebel object 
definitions, editing cascading style sheet (CSS) or Web template files, creating or 
modifying scripts, or modifying configuration files.

For example, most of the fonts used to display data and user interface elements in 
the Siebel application are specified by editing cascading style sheet files such as 
jctrls.css or main.css.

On the other hand, the font used in displaying charts is specified using the 
DefaultChartFont parameter. This parameter is defined in the configuration files, 
such as siebel.cfg, on the Siebel Mobile and Dedicated Web Client. It is defined on 
the Siebel Server as a parameter on the Application Object Manager.
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For more information about configuration file parameters, see Appendix A, 
“Configuration Parameters.” For more information about Siebel Server parameters, 
see Siebel Server Administration Guide.

Global deployment and support of multiple languages and Unicode environments 
present some special issues, in particular concerning fonts used in the Siebel client. 
For more information, see Global Deployment Guide.

For more information about various topics in configuring Siebel applications, see:

■ Siebel Tools Reference

■ Siebel Tools Online Help

■ Configuration Guidelines

Application Names and Siebel Clients
For each of the Siebel eBusiness Applications, closely related but distinct 
configuration parameters help identify the application internally and to end users, 
through the user interface.

■ ApplicationName specifies an internal name used by the system.

■ ApplicationTitle specifies a name that is to appear in the browser title bar.

■ ApplicationSplashText specifies the name that appears in the splash screen 
when the application is started.

These parameters are already defined appropriately for each Siebel application in 
the corresponding configuration file. For example, for Siebel Call Center, which uses 
the file uagent.cfg, ApplicationName is set to Siebel Universal Agent, and both 
ApplicationTitle and ApplicationSplashText are set to Siebel Call Center.

As with many of the parameters described in Appendix A, “Configuration 
Parameters,” these configuration parameters are used only for the Siebel Mobile or 
Dedicated Web Client. The application is determined by the configuration file that 
is associated with the shortcut you run.

For information about equivalent parameters on the Siebel Server, applicable to the 
Siebel Web Client, see Siebel Server Administration Guide.
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User Preferences and Siebel Clients
Preferences that Siebel users specify, such as those in the User Preferences screen, 
accessed from the View menu, are saved to the client or server machine, depending 
on which type of client is being used:

■ For users on Siebel Mobile or Dedicated Web Client, user preferences are saved 
by default on the local client machine.

By default, user preference data is saved in the SIEBEL_CLIENT_ROOT\bin 
directory. A different location for this data, including a network location, can be 
specified by specifying a value for the optional configuration parameter 
SharedModeUsersDir. For more information, see “Siebel Application 
Parameters for Client” on page 128.

■ For users on Siebel Web Client, user preferences are saved on the Siebel Server.

By default, user preference data is saved in the UserPref subdirectory under the 
directory containing the Siebel File System. A different location for this data can 
be specified on the Siebel Server or Application Object Manager level by 
modifying the value of the configuration parameter SharedModeUsersDir.

User preference filenames are in the form user_ID&Siebel_appname.spf—for 
example, SADMIN&Siebel Universal Agent.spf for the user SADMIN running Siebel 
Call Center.

Locale Settings for Siebel Clients
Siebel clients adopt locale settings as follows:

■ The Siebel Web Client adopts the locale settings from the Application Object 
Manager.

■ The Siebel Mobile and Dedicated Clients adopt the locale settings defined in the 
client operating system’s regional settings.

For more information, see Global Deployment Guide.
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Siebel Systems supports Mobile and Dedicated Web Client installations on the 
hardware and operating systems described in System Requirements and Supported 
Platforms. This installation is based on default installation parameters set by Siebel 
Systems.

You can use the Siebel Packager utility to prepare custom installation packages for 
distribution to end users. A model client installation is prepared as the basis for a 
package. For details, see Chapter 5, “Using Siebel Packager Utility.”

The Siebel administrator should perform the following general client installation 
and setup procedures:

1 Review the preinstallation tasks. See “Before Installing” on page 28.

2 Create a model installation by running the Siebel client installer (for Mobile and 
Dedicated Web Client). See “Installing the Siebel Mobile and Dedicated Web 
Client” on page 32.

3 If you want to install the Siebel Sample Database, run the Sample Database 
installer. See “Installing the Sample Database” on page 39.

4 Verify the installation by performing the postinstallation tasks. See “After 
Installing” on page 42.

5 Log into the Siebel application. See “Logging into Your Siebel Application” on 
page 48.

6 Configure the Siebel Mobile Web Client and verify connection to Siebel Remote 
Server. See “Configuring and Using Mobile Web Client” on page 79.

7 As necessary, modify values for configuration parameters for the Mobile or 
Dedicated Web Client. See Appendix A, “Configuration Parameters.”
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8 If you want to prepare custom software installation packages for distribution to 
end users based on the model installation, run the Siebel Packager utility. See 
Chapter 5, “Using Siebel Packager Utility.”

This chapter also describes startup options for the Siebel Mobile and Dedicated 
Client, and provides information about uninstalling Siebel client software.

Before Installing
Review the following issues and perform the related tasks before running the Siebel 
client installer:

■ “Administrative Rights for Installation” on page 28

■ “Directory Names” on page 29

■ “Requirements and Recommendations for Siebel Client” on page 29

■ “Database Connectivity Software” on page 30

■ “Other Third-Party Software” on page 31

Administrative Rights for Installation
Administrative rights are required for installation or uninstallation of the Siebel 
Mobile or Dedicated Web Client.

For information on setting administration rights, consult the operating system 
manuals for the version of Microsoft Windows on which the application is installed.

User Rights for Running Siebel Client
User rights to read and write in Siebel client installation directories are required for 
running the Siebel Mobile or Dedicated Web Client.

For information on setting user rights, consult the operating system manuals for the 
version of Microsoft Windows on which the application is installed.
28 Siebel Web Client Administration Guide Version 7.5.3



Installing Mobile and Dedicated Web Clients

Before Installing
Directory Names
By default, the Siebel client installer assumes an installation directory of 
C:\sea7xx\client. In this book, the directory into which you install the Siebel client 
is often referred to as SIEBEL_CLIENT_ROOT. If you install into a directory other 
than the default, make appropriate substitutions through the remainder of this 
chapter.

CAUTION: Do not install other Siebel components, such as the Siebel Tools Client, 
into the same directory where you have installed the Siebel client, such as 
C:\sea7xx\client. Install each component into a separate directory, or into a 
subdirectory of the top-level directory, such as a subdirectory of C:\sea7xx. You can, 
however, install the Sample Database in the same directory as the Siebel client. If 
you install multiple Siebel components on the same machine, determine your 
directory-naming convention before you begin installing. For more information on 
installing the Siebel Tools Client, see Siebel Tools Reference.

It is recommended that you use installation directory names that describe both the 
version number and the component being installed. 

CAUTION: The directory name must not include special characters (such as 
apostrophes, accents, and ampersands), slashes, or spaces (instead, use 
underscores), and must be unique within the Siebel Enterprise Server. The letters 
may be lower- or uppercase. The total path must not exceed 18 characters. These 
characters must be ASCII characters, not extended characters.

Requirements and Recommendations for Siebel Client
Before beginning Siebel client installation, review the requirements and 
recommendations for hardware, system software, and third-party software 
described in System Requirements and Supported Platforms.
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Database Connectivity Software
Dedicated Web Client computers connecting directly to database servers must have 
the correct vendor-specific database connectivity software installed. See System 
Requirements and Supported Platforms.

NOTE: The correct version of connectivity software must be installed before 
installing the Siebel client.

When you have installed your connectivity software, configure it as follows:

■ For IBM DB2 Universal Database for Windows and UNIX, you install and 
configure the DB2 client software to connect to the Siebel Database. The connect 
string and tableowner information should be recorded on the Deployment 
Planning Worksheet in the Siebel Server Installation Guide for the operating 
system you are using. Use the ODBC driver version specified in System 
Requirements and Supported Platforms.

■ For Microsoft SQL Server, you download and install the Microsoft Data Access 
Components (MDAC) specified in System Requirements and Supported 
Platforms. The Siebel client uses these drivers, but creates its own ODBC data 
source during installation. This data source should be recorded on the 
Deployment Planning Worksheet in the Siebel Server Installation Guide for the 
operating system you are using.
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■ For Oracle Database, you install and configure the Oracle client software to 
connect to the Siebel Database. The connect string and tableowner information 
should be recorded on the Deployment Planning Worksheet in the Siebel Server 
Installation Guide for the operating system you are using. Use the driver version 
specified in System Requirements and Supported Platforms.

NOTE: If you are upgrading from Oracle 7.x client to a later version of the Oracle 
client, you must uninstall and reinstall the Siebel Dedicated Web Client after 
upgrading the Oracle client.

If you are running an Oracle client, be sure to set the NLS_SORT parameter to 
BINARY or choose a setting for NLS_LANG that includes binary. These settings 
are required for adequate performance from the Dedicated Web Client. For more 
information, see the Upgrade Guide and the Siebel Server Installation Guide for 
the operating system you are using.

■ For IBM DB2 Universal Database for OS/390 and z/OS, you use DB2 Connect to 
connect from the Dedicated Web Client to the Siebel Database. For details, see 
Implementing Siebel eBusiness Applications on DB2 UDB for OS/390 and z/OS.

Other Third-Party Software
Your Siebel application requires some third-party software products to be installed 
on the local client, for full functionality. For more information about where to obtain 
this software, see System Requirements and Supported Platforms.

Install the following third-party software for full Siebel functionality for the Siebel 
Mobile and Dedicated Web Client:

■ The Siebel client software requires that MFC Runtime components are installed 
as a prerequisite to installation of the Siebel client. If this software component 
is missing, the client installer exits with a log message stating the installation 
requirement of MFC components.
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■ Microsoft Data Access Components (MDAC) components must be installed for 
all Mobile and Dedicated Web Clients, as described in “Database Connectivity 
Software” on page 30.

NOTE: Remember to install on the client machines all software required to view any 
standard attachment types your deployment may use within the Siebel 
implementation.

Installing the Siebel Mobile and Dedicated Web Client
This section describes how to install the Siebel Mobile and Dedicated Web Client.

NOTE: This book assumes that installations are performed by administrators, not end 
users.

The software installed on the user’s machine for Siebel Mobile Web Client and 
Dedicated Web Client is identical. Therefore, a single installer provides the software 
necessary to run either type of client. For more information, see “Siebel Mobile and 
Dedicated Web Clients” on page 20.

The standard Siebel Mobile and Dedicated Web Client installer performs the 
following:

■ Checks the client computer to verify whether required components have already 
been installed.

■ Checks the client computer to verify installation of the proper version of 
Microsoft Data Access Components (MDAC) components.

■ Creates all required ODBC data sources.

■ Installs Siebel client software and allows the installation log file to be viewed.
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Before you begin installation, see System Requirements and Supported Platforms.

NOTE: Each Siebel client is designed to support only a single Siebel Enterprise. To 
support multiple Enterprises on a single machine for testing purposes, be sure to 
install clients in separate directories. For more information, see “Directory Names” 
on page 29.

To install the Siebel Mobile or Dedicated Web Client software

1 Using Windows Explorer, navigate to the root directory of the Siebel eBusiness 
Applications Web Client Programs CD-ROM, then navigate to the seaw folder. 
Use the version of this CD-ROM that includes the languages you need.

CAUTION: You must run this and other installation programs from the CD-ROM or 
a network drive mapped to a drive letter. If you attempt to install from an 
unmapped network drive, the installer may be unable to locate files it needs to 
proceed and may fail.

2 Double-click install.exe to start the Siebel client installer. 

3 From the Choose Setup Language screen, choose the language in which to 
conduct the installation, then click OK.

The default installation language is the one that corresponds to the current 
regional settings on the installation machine.

4 If you have an existing client installation, you can choose to add language packs 
to this installation.

■ If you are installing a new instance of the Siebel client, click Next, then go to 
Step 5.

■ If you are adding languages:

❏ Click in the check box next to the line identifying the installation, then 
click Next.
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❏ Click in the check box next to each language you are installing, then click 
Next. 

The setup program copies language pack files to the local host machine’s 
hard disk, and then exits. Skip the rest of this procedure.

5 In the Welcome screen, click Next.

6 In the Setup Type screen, select the type of installation to perform. All options 
install a common set of components. The Custom option lets you specify which 
optional components to install. Typical and Compact options install subsets of 
the optional components.

■ Typical. Installs all base Siebel client components, plus the following optional 
components: First Logic Configuration Files, Packager Utility, Siebel Charts, 
Siebel Debug Symbols. This option is recommended for most users.

■ Compact. Installs all base Siebel client components, plus the following 
optional component: Siebel Charts. Select this option for an installation with 
minimum storage requirements.

■ Custom. Installs all base Siebel client components and lets you specify 
whether to install the following optional components: Server Manager, First 
Logic Configuration Files, Packager Utility, Siebel Charts, ODBC Driver for 
External Oracle Database, and Siebel Debug Symbols. Some of these options 
are preselected by default.

NOTE: Siebel administrators should use the Custom setup option and make 
sure to install the Server Manager and the Packager utility.

7 While still in the Setup Type screen, verify that the Siebel client installation 
directory listed is correct. The default directory is C:\sea7xx\client. 

■ Click Next to accept the default directory. 

■ Click Browse to select a different destination directory. 

For details on pathname requirements, see “Directory Names” on page 29.

If you are performing a:

■ Typical or Compact installation, go to Step 9 on page 35.
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■ Custom installation, go to Step 8.

8 For a custom installation, select from the Select Components screen the optional 
components you want to install. This screen appears only if you chose Custom 
installation in Step 6 above. 

9 In the Choose Languages screen, select the languages to install. The language in 
which you are performing the installation, specified in Step 3 on page 33, is 
preselected as a default.

Verify that your destination machine has sufficient disk space for the 
installation, then click Next.

NOTE: The installer displays space requirements for only one drive. The drive that 
contains the TEMP directory requires at least 10 MB free prior to installation. 
Also, pay attention to your hard drive file system configuration. Using a FAT 
configuration with a 64-KB allocation unit is not recommended, since this may 
leave insufficient space for installation of all necessary components and cause 
the installation to fail.

10 In the Select Client Type screen, specify if you are installing the Mobile Web 
Client or the Dedicated Web Client, then click Next.

NOTE: Some of the remaining installation steps in this procedure apply only if you 
are installing Mobile Web Client, or only if you are installing Dedicated Web 
Client.

For Mobile Web Client installations, go to Step 12 on page 36.

11 Dedicated Web Client installations only: In the Server Database screen, select the 
type of server database on which you are implementing your Siebel application. 
Choose one of the following, then click Next:

■ IBM DB2 Universal Database 7.2 (for Windows and UNIX)

■ Microsoft SQL Server 2000
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■ Oracle Database

Based on your choice, the Siebel client installer validates that the correct 
database connectivity software has been installed.

NOTE: For IBM DB2 Universal Database for OS/390 and z/OS, see Implementing 
Siebel eBusiness Applications on DB2 UDB for OS/390 and z/OS.

12 In the first Server Locations screen, enter your Siebel File System server 
connectivity information, then click Next.

NOTE: Siebel File System connectivity information can be the UNC share name of 
the Siebel File System directory (for example, \\SRV1\siebfile), or a drive letter 
mapped to the Siebel File System directory (for example, K:\).

13 In the second Server Locations screen, enter your Siebel Remote Server 
connectivity information, then click Next.

For Mobile Web Client installations, go to Step 15 on page 37.

14 Dedicated Web Client installations only: In the Database Identification screen, 
enter the following information. Specify information for the database you 
specified in the Server Database screen in Step 11 on page 35:

■ For IBM DB2 Universal Database for Windows and UNIX, specify the 
Database Alias and Table Owner, then click Next.

■ For Microsoft SQL Server, specify the Server Name and Database Name, then 
click Next.

■ For Oracle Database, specify the Database Alias and Table Owner, then click 
Next.

NOTE: For IBM DB2 Universal Database for OS/390 and z/OS, see Implementing 
Siebel eBusiness Applications on DB2 UDB for OS/390 and z/OS.

Go to Step 16 on page 37.
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15 Mobile Web Client installations only: In the Enterprise Server Information 
screen, specify the address of the Siebel Gateway (Gateway Server) and the 
name of the Enterprise Server, then click Next. 

NOTE: The Siebel Gateway address is typically the machine name or VIP where 
the Siebel Gateway is running.

Go to Step 17.

16 Dedicated Web Client installations only: In the Enterprise Server Information 
screen, specify the Gateway Server Address (for Siebel Gateway) and Enterprise 
Server to which this client will connect for administration. 

The address specified for the Siebel Gateway varies depending on whether your 
Siebel Servers are using Resonate Central Dispatch to support connection 
brokering:

■ If you are using Resonate Central Dispatch, the Siebel Gateway address is the 
Gateway VIP (virtual IP address) of the machine on which the Siebel 
Gateway is installed.

■ If you are not using Resonate Central Dispatch, enter the network name or 
the IP address of the machine on which the Siebel Gateway is installed.

To enter a specific port number, append the Gateway Server string with a colon 
and the desired port number.

The Enterprise Server name is the name under which the Siebel Servers that 
support this client’s server database were installed.

17 In the Server Request Information screen, specify the name of the Siebel Server 
on which the Server Request Broker component is operating. This component is 
used for dynamic assignment and other interactive operations. Then click Next. 

NOTE: If you are using Resonate Central Dispatch to load balance server requests, 
leave this field blank. If you are not using Resonate Central Dispatch to load 
balance server requests, you must specify the Siebel Server name for server 
requests.
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18 In the Search Configuration screen:

■ If you will use Siebel Search, enter the following for the server on which 
Siebel Search is operating:

❏ Hostname

❏ Port Number

■ If you will not use Siebel Search, accept the default parameters, then click 
Next.

NOTE: For system requirements and other information on implementing Siebel 
Search, consult Siebel Search Administration Guide.

19 In the Select Program Folder screen, enter the name of the program folder that 
will contain your Siebel shortcuts, then click Next. 

The default name is Siebel Client 7.x.x. You can use spaces and the backslash 
(\) in folder names to create a folder hierarchy.

CAUTION: If you are deploying clients operating against an Oracle database, do 
not include parentheses in the labels of the Siebel shortcuts if you modify them. 
Including parentheses prevents the application from connecting to the Oracle 
database.

The setup program copies files to the local host machine’s hard disk. A status 
bar in the Setup Status dialog box indicates the progress of the installation. A 
separate set of files is installed for each language specified in Step 9 on page 35, 
in addition to those installed for the base installation.

20 Review the Event Log screen, then click Next.

This log provides details of the steps the installer has performed during your 
Siebel client installation.

21 Review the Registry Log screen, then click Next.

This log provides details of the registry information the installer has performed 
during your Siebel client installation.
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22 Click Finish in the InstallShield Wizard Complete screen.

The Siebel client installation is now finished. Siebel application shortcuts are 
created in the program folder specified in Step 19 on page 38. For more 
information, see “Siebel Client Shortcuts” on page 46.

23 Review the installation log to verify that all components installed successfully. 

To verify successful installation, see “After Installing” on page 42.

Installing the Sample Database
This section describes how to install the Siebel Sample Database.

The Sample Database contains example data of various kinds to help you 
understand how the Siebel eBusiness Applications work. You can install the Sample 
Database for the Siebel Mobile or Dedicated Web Client. Or, you can also install the 
Sample Database for Siebel Tools. The Sample Database, like the local database 
used with the Siebel Mobile Web Client, is based on SQL Anywhere.

NOTE: Installation of the Siebel Sample Database is optional and applies only to 
Siebel Mobile and Dedicated Web Clients, not to the Siebel Web Client. You must 
install the client before you can install the Sample Database.

The installer for all language versions of the Sample Database exists on the Siebel 
Sample Database CD-ROM.

To install the Siebel Sample Database

1 Use Windows Explorer to navigate to the root directory of the Siebel Sample 
Database CD-ROM, then navigate to the sample folder.

CAUTION: You must run this and other installation programs from the CD-ROM or 
a network drive mapped to a drive letter. If you attempt to install from an 
unmapped network drive, the installer may be unable to locate files it needs to 
proceed and may fail.

2 Double-click install.exe to start the installer.
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3 From the Choose Setup Language screen, choose the language in which to 
conduct the installation, then click OK. 

4 From the Welcome screen, click Next.

5 In the Setup Type screen, select the type of Siebel installation to perform:

■ Typical. Installs the Sample Database plus optional components. This option 
is recommended for most users.

■ Compact. Installs the Sample Database plus optional components.

■ Custom. Installs the Sample Database and lets you specify whether to install 
the following optional components: Sample Files and Sample Search Index. 
These options are selected by default.

NOTE: For the standard installer for the Siebel Sample Database, the Setup Type 
options currently install the same components. In a customized installation, 
these options may install different elements.

6 While still in the Setup Type screen, verify that the Sample Database installation 
directory listed is correct. 

CAUTION: Be sure that the directory path in the Setup Type screen is the same as 
that of the Mobile or Dedicated Web Client installation. The path must include 
the root level of the client. The default directory is C:\sea7xx\client. 

■ Click Next to accept the default directory.

■ Click Browse to select a different destination directory.

For details on pathname requirements, see “Directory Names” on page 29. 

If you are performing a:

■ Typical or Compact installation, go to Step 8 on page 41.

■ Custom installation, go to Step 7.
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7 For a custom installation, select from the Select Components screen the optional 
components you want to install. This screen appears only if you chose Custom 
installation in Step 5 on page 40. 

8 In the Choose Languages screen, select the languages to install. The language in 
which you are performing the installation, specified in Step 3 on page 40, is 
preselected as a default.

Verify that your destination machine has sufficient disk space for the 
installation, then click Next.

NOTE: Before installing a non-ENU language, be sure the SQL Anywhere database 
engine is running. The SQL Anywhere database engine is started when the 
Siebel Mobile or Dedicated Web Client is connected to the Sample Database. If 
the configuration parameter AutoStopDB is FALSE (default), then the database 
engine continues to run after the user logs out of the Siebel applications. If this 
parameter is TRUE, then the engine exits when the user logs out.

9 In the Select Program Folder screen, enter the name of the program folder that 
will contain your Siebel shortcuts, then click Next.

The default name is Siebel Client 7.x.x. You can use spaces and the backslash 
(\) in folder names to create a folder hierarchy.

The setup program copies files to the local host machine’s hard disk. A status 
bar in the Setup Status dialog box indicates the progress of the installation. A 
separate set of files is installed for each language specified in Step 8, in addition 
to those installed for the base installation.

10 Review the Event Log screen, then click Next.

This log provides details of the steps the installer has performed during your 
Sample Database installation.
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11 Click Finish in the Setup Complete screen. 

The installation is now finished. Siebel Demo application shortcuts (for 
example, Siebel Call Center Demo - ENU) are created in the program folder 
specified in Step 9 on page 41. For more information, see “Siebel Client 
Shortcuts” on page 46.

To verify successful installation of the Sample Database, see “After Installing” on 
page 42.

NOTE: By default, the SRF file contains the appropriate localization strings to display 
correct field labels for the languages you have chosen when installing the Sample 
Database. However, if you later make a change to the Siebel Repository, you must 
import non-ENU localization strings for non-ENU field labels before compiling the 
new SRF file. To import non-ENU localization strings, run Programs > Siebel Client 
7.x.x > Import LANGUAGE (such as Import FRA for French). A batch process is 
initiated to import the localization strings.

After Installing
Review the following issues and perform the related tasks after running the Siebel 
client installer, to verify a successful Siebel client installation:

■ “Configuring Client When Siebel VB or Siebel eScript Not Licensed” on page 42

■ “Verifying the Siebel Client Directory Structure” on page 43

■ “Siebel Client ODBC Data Sources” on page 45

■ “Siebel Client Shortcuts” on page 46

Configuring Client When Siebel VB or Siebel eScript Not Licensed
The default configuration files for the Siebel client have Siebel VB or Siebel eScript 
enabled. This is done by setting the parameter EnableScripting to TRUE. If this 
parameter is TRUE, but you do not have either Siebel VB or Siebel eScript licensed, 
the client does not start. An error message is returned, indicating that you must turn 
off Siebel VB or Siebel eScript before running the client.
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To configure Siebel client when Siebel VB or Siebel eScript are not licensed

■ Set EnableScripting to FALSE in the configuration file used by your Siebel 
client configuration. This configuration file resides in the directory 
SIEBEL_CLIENT_ROOT\bin\LANGUAGE.

Verifying the Siebel Client Directory Structure
The Siebel client installer creates directories on each Siebel client. Use Windows 
Explorer to verify the directory structure on your computer. Following are an 
example of the directory structure of a typical Siebel client installation and 
descriptions of individual directories.

sea752
client

actuate
bin
charts
fonts
isstempl
lex
local
locale
log
msgtempl
objects
packager
public
reports
sample (if Sample Database was installed)
sqltempl
temp
upgrade
webtempl

■ SIEBEL_CLIENT_ROOT. The directory for the Siebel client installation, such as 
C:\sea752\client. This installation directory contains the directories identified 
below. You can change the name during the installation process. For more 
information, see “Directory Names” on page 29.

■ actuate. Contains all the Actuate-related files, for Siebel Reports.

■ bin. Contains all binary files (*.exe, *.dll, *.cfg, *.ssf, *.pre), configuration files, 
user preference files, and language-specific files.
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■ charts. Contains files for generating charts.

■ fonts. Contains font files.

■ isstempl. Contains templates for the SIS (Siebel Interactive Selling) CDA 
application.

■ local. Where the local database is stored.

■ locale. Stores language-specific files.

■ log. Stores the log files from client operations, such as synchronization.

■ msgtempl. Stores message files used by the client.

■ objects. Contains compiled Siebel repository (SRF) files and language-specific 
files.

■ packager. Stores files used by the Siebel Packager utility.

■ public. Contains HTML files, JavaScript files, and images used by the Web Client.

■ reports. Contains all report files.

■ sample. Where the Sample Database is installed.

■ sqltemp. Contains SQL scripts. These files should not be modified.

■ temp. Contains working report files.

■ upgrade. Will contain Siebel Anywhere upgrade files retrieved by the user.

■ webtempl. Contains Siebel Web templates.
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Siebel Client ODBC Data Sources
The Siebel client installer creates the ODBC data sources shown in Table 4. By 
default, these are created as user data sources, which are visible only to the user 
account under which the Siebel client is installed. The drive letter and directory at 
the end of each data source name varies, depending on where you have chosen to 
install the Siebel client. 

NOTE: If the database server is Microsoft SQL Server, the client must be configured 
to use SQL Server authentication. All ODBC data sources and the SQL Server 
database should be configured using SQL Server authentication. 
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If two or more users need to login using the same Windows client machine, it is 
necessary to install the client using the SystemDSN parameter instead of the 
UserDSN parameter in the siebel.ini file. For more information about the siebel.ini 
file and custom installer packages, see Chapter 5, “Using Siebel Packager Utility.”

NOTE: Make sure to use the ODBC drivers described in System Requirements and 
Supported Platforms.

Siebel Client Shortcuts
The Siebel client and Sample Database installers create shortcuts in the Siebel 
program folder for the modules you have installed. Separate shortcuts are installed 
for each installed language.

For information about customizing the shortcuts, see “Siebel Mobile and Dedicated 
Web Client Startup Options” on page 50.

Table 4. Siebel Client ODBC Data Sources

Data Source When It Is Used

SEAW DB2UDB 
SIEBEL_CLIENT_ROOT

For IBM DB2 installations only, connects to the DB2 
database.

SEAW Local Db 
SIEBEL_CLIENT_ROOT

Connects to the local SQL Anywhere database.

SEAW MSQL 
SIEBEL_CLIENT_ROOT

For Microsoft SQL Server installations only, connects 
to the Microsoft SQL Server database.

SEAW Oracle 
SIEBEL_CLIENT_ROOT

For Oracle installations only, connects to the Oracle 
database. This data source is used only by the Siebel 
administrator when creating Siebel Anywhere upgrade 
kits.

SEAW Search 
SIEBEL_CLIENT_ROOT

ODBC data source used by Hummingbird 
SearchServer; created only if Hummingbird is 
installed. This data source is always created as a 
SystemDSN.

SEAW Text 
SIEBEL_CLIENT_ROOT

Used for reporting and data merge into the local SQL 
Anywhere database.
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Some of the Siebel application shortcuts installed by the client installer are listed 
below. When you run a shortcut to start a Siebel application, you can connect to 
the database server (for LAN-connected users), to an initialized local database, or 
to the Sample Database (if it has been installed). 

Demo application shortcuts connect to the Sample Database automatically. Other 
shortcuts run utilities such as Siebel Packager or synchronization programs.

■ Packager. Use this shortcut to start the Siebel Packager utility.

■ Siebel Call Center. Use this shortcut to start Siebel Call Center. 

■ Siebel Marketing. Use this shortcut to start Siebel Marketing.

■ Siebel Remote. Use this shortcut to start the Siebel Remote stand-alone 
synchronization program (siebsync.exe). For more information, see “User 
Synchronization Options for Mobile Web Client” on page 83.

■ Siebel Sales. Use this shortcut to start Siebel Sales. 

■ Siebel Service. Use this shortcut to start Siebel Service.

■ Import LANGUAGE. The Import LANGUAGE shortcut is created for each non-
English version of the Sample Database you install. For a French installation, for 
example, the shortcut name is Import FRA. Use this shortcut to import a version 
of the Sample Database for your installed language. See “Installing the Sample 
Database” on page 39.

■ Siebel Call Center Demo. Use this shortcut to start Siebel Call Center, using the 
Sample Database.

■ Siebel Marketing Demo. Use this shortcut to start Siebel Marketing, using the 
Sample Database.

■ Siebel Sales Demo. Use this shortcut to start Siebel Sales, using the Sample 
Database.

■ Siebel Service Demo. Use this shortcut to start Siebel Service, using the Sample 
Database.
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Logging into Your Siebel Application
This section provides basic instructions for logging into your Siebel application 
through these Siebel client types:

■ Siebel Dedicated Web Client

■ Siebel Mobile Web Client

■ Siebel Web Client

Before logging in, review requirements described in this book or related documents. 
Also note the following issues:

■ After the Siebel Database has been installed, users will be unable to use the 
Siebel application until the license key for a base Siebel application has been 
entered into the Siebel Database. You do this using the Siebel Dedicated Web 
Client or Siebel Tools. Additional licenses or licenses for optional modules can 
be entered subsequently using the Siebel Web Client, as well as the Siebel 
Dedicated Web Client or Siebel Tools. 

For detailed information, see Applications Administration Guide.

■ The user name and password used to log into Siebel applications must be those 
of an employee with a valid position and division defined in the Siebel Database. 
Therefore, the first time you log into the server database, do so as an 
administrator. Use SADMIN as the user name and password. Then you can set 
up other users as employees with defined positions and responsibilities. 

For more information on setting up employees, see Security Guide for Siebel 
eBusiness Applications.

To log into your Siebel application using the Siebel Dedicated Web Client

1 Double-click one of the Siebel shortcuts in the program folder, such as Siebel 
Call Center.

2 Log in using a valid user ID and password.

3 Specify the Server database and click OK.

The first time you log into the Server database, the system prompts you to enter 
your site’s license key number, which is located on your CD-ROM case.
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4 Enter your license key number in the dialog box that appears and click OK. 

If you see a warning message dialog box, click OK, and then enter your license 
key number in the dialog box that appears.

NOTE: If you need to access license keys at a later time, such as to enter additional 
license keys, navigate to the Site Map, then choose Application Administration 
> License Keys.

To log into your Siebel application using the Siebel Mobile Web Client

1 Double-click one of the Siebel shortcuts in the program folder, such as Siebel 
Call Center.

2 Log in using a valid user ID and password.

3 Specify the Local database and click OK.

NOTE: When logging into a local database for the first time, users are 
automatically prompted to connect to the Siebel Server and download the local 
database. Users should attempt this only after a local database has been 
extracted for them.

For more information on Siebel Remote and extracting local databases, see Siebel 
Remote and Replication Manager Administration Guide.

To log into your Siebel application using the Siebel Web Client

1 Open your Web browser.

2 Go to the URL for your Siebel application.

3 Log in using a valid user ID and password.

The Siebel application you are connecting to is already configured to work with 
a specific database. You do not need to specify a database to connect to.
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Siebel Mobile and Dedicated Web Client Startup Options
If you need to customize the Siebel eBusiness Application shortcuts described in 
“Siebel Client Shortcuts” on page 46, you can do so by modifying shortcut 
properties, and changing the value for the Target field.

CAUTION: Do not modify the location displayed in the shortcut property labeled 
“Start in.” Doing so may cause problems when the Upgrade Wizard is run.

The Siebel Mobile and Dedicated Web Clients run an executable program called 
siebel.exe, followed by various startup options. For example, the shortcut for Siebel 
Call Center - ENU is defined as shown below. For this example, the only option used 
is /c, to specify the configuration file.

SIEBEL_CLIENT_ROOT\BIN\siebel.exe /c SIEBEL_CLIENT_ROOT\bin\ENU\uagent.cfg

The siebel.exe program may also be run from an MS-DOS window. In this case, the 
startup options may be entered directly on the command line. 

The available startup options are described in Table 5.

Table 5. Siebel Mobile and Dedicated Web Client Startup Options

Startup Option Description

/c config_file Required. Specifies the path and filename for the configuration 
file to use, such as siebel.cfg for Siebel Sales or uagent.cfg for 
Siebel Call Center.

/d data_source Required. Specifies the data source to connect to, as defined in 
the configuration file.

/l language Specifies the three-letter code for the language to use for this 
client session, such as ENU for U.S. English. The applicable 
language pack must have been installed for the client.

/u username Specifies the user name. The Demo shortcuts specify predefined 
demo users using /u and /p options.

Note: Security issues must be considered in using these options 
for access to a live production system.
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Uninstalling the Mobile and Dedicated Web Clients
To uninstall the Siebel Mobile or Dedicated Web Client, run the Siebel Systems 
Uninstallation Manager from the Add/Remove Programs Control Panel in Microsoft 
Windows. 

Any file that is updated by a user after installation is not deleted. After 
uninstallation, files remaining in the client installation directory can be safely 
deleted, at the discretion of the administrator.

Automated Uninstallation
You can also perform an automated uninstallation (also known as unattended or 
silent uninstallation). To do this, run the batch file siebunis.bat, located in the 
directory SIEBEL_CLIENT_ROOT/bin. Running siebunis.bat in turn runs other batch 
files, which perform the uninstallation tasks. In siebunis.bat, the token %1% 
represents the Siebel client installation root directory, referred to in this book as 
SIEBEL_CLIENT_ROOT.

To perform automated uninstallation

1 In a command shell, change to the directory SIEBEL_CLIENT_ROOT/bin.

/p password Specifies the password for this user.

Note: You must consider the additional security risks involved 
in using the /p startup option. Risks apply whether the option 
is used on the command line directly or whether it is defined 
within a Siebel client shortcut.

/ctisim Runs the Communications Simulator. This option should 
generally be used only with predefined Demo shortcuts that 
specify it, such as Siebel Call Center Demo.

For more information, see Siebel Communications Server 
Administration Guide.

/s spool_file Specifies spooling SQL to a specified output file. This option 
may be useful for troubleshooting purposes.

Table 5. Siebel Mobile and Dedicated Web Client Startup Options

Startup Option Description
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2 Enter the following at a command line:

siebunis $SiebelRoot
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This chapter provides information about how to deploy the Siebel Web clients 
covered in this book: Siebel Web Client, Mobile Web Client, and Dedicated Web 
Client.

NOTE: In this chapter, the term “Web client” generally refers to all the Siebel client 
types mentioned above.

In particular, this chapter describes Web browser settings that affect Siebel 
application behavior, such as security settings, ActiveX controls, cookies, Java 
software environment, and so on.

NOTE: Supported browser products and versions are documented in System 
Requirements and Supported Platforms. This book is located on Siebel SupportWeb, 
under Installation and Release Documentation/Supported Platforms.

About Deployment Modes for Siebel Web Clients
There are two fundamental modes of deployment for a Siebel Web client:

■ Standard interactivity

■ High interactivity
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The user interface characteristics of Siebel eBusiness Applications, and the 
experience of your end users, depends greatly on the interactivity mode in which 
you deploy your applications.

NOTE: For information about which Siebel applications use each of these deployment 
modes, refer to System Requirements and Supported Platforms. For information 
about configuration issues for deployment modes, refer to Siebel Tools Reference.

To deploy Siebel clients, software prerequisites and configuration requirements 
must be considered for each deployment mode.

Each mode provides performance and usability characteristics that may offer 
advantages for a given environment. In choosing the appropriate deployment mode 
of the Web client, you must carefully consider the target users of your Siebel 
applications, and carefully evaluate the requirements applicable to your 
deployment choices.

You must coordinate all of your deployment activities—those described in this book 
and those described in related books such as Siebel Server Installation Guide. The 
deployment requirements for client machines must correspond to your target user 
characteristics.

Table 6 describes the basic differences between the two deployment modes. The 
sections that follow provide additional information about each mode.

Table 6. Comparison of Standard Interactivity and High Interactivity Modes

Feature Standard Interactivity High Interactivity

Support for broader variety of browsers X

Uses JavaScript technology X X

Uses ActiveX technology X

Uses Java technology X
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Standard Interactivity
The standard interactivity client provides users of Siebel applications with a user 
experience similar to that for users of traditional Web applications for customer 
applications, such as those for consumers. The usability characteristics of this 
deployment mode will be familiar to users of typical consumer Web sites, such as 
CNN.com, Amazon.com, and so on.

Most user interactions in standard interactivity deployment mode result in a page 
refresh. When creating a new record, the user clicks the New button (which 
refreshes the page as the application displays a new entry form), enters the relevant 
data, then clicks the Save or Submit button (which again refreshes the page as the 
application redisplays the original page). Similarly, when a user browses through a 
list of records, the page refreshes each time a new record is selected.

When users quickly enter, review, and edit large numbers of records, as is the case 
for employee applications such as Siebel Call Center, the user experience of 
standard interactivity mode deployment may not meet usability requirements. 
However, sometimes it may be desirable to deploy employee applications in 
standard interactivity mode.

High Interactivity
The high interactivity client is designed to provide users of Siebel applications with 
a user experience similar to that for users of traditional GUI-based client 
applications, such as for Microsoft Windows.

High interactivity reduces the number of page refreshes, compared to standard 
interactivity—when interacting with the application, browsing through records, and 
so on. This is made possible by making data-only updates from the server. The 
application thus makes optimal use of network bandwidth.

For example, a high interactivity client does not require a page refresh for creating 
a new record. A user creates a new record by clicking the New button. A new row 
is created in a list dynamically, without a page refresh. The user enters the relevant 
data, then clicks outside of the record (“steps off of the record”) to implicitly 
commit the change—again, without a page refresh.

Some of the features of the high interactivity framework are:

■ Fewer page refreshes.
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■ Support for client-side scripting.

■ Support for implicit commit. This feature enables automatic saving when a user 
steps off of a new or modified record.

■ Other usability features. Such features include MVG shuttle applets; drag-and-
drop column reordering; drag-and-drop file attachments; keyboard shortcuts; 
smart controls for calendar, calculator and currency; and applet scrollbars.

The high interactivity framework provides performance and usability 
enhancements by taking advantage of capabilities supported by Microsoft Internet 
Explorer browsers. These capabilities include Document Object Model (DOM), 
Java, and ActiveX controls.

Deploying Siebel applications in high interactivity mode requires that customers 
and their users adhere to strict guidelines regarding the deployed operating system, 
Web browser version and settings, and Java software environment.

Overview of Deployment Requirements
Certain features and functions in Siebel eBusiness Applications require particular 
browser settings. Unless stated, all supported browser versions require the settings 
and configuration outlined in this document. The requirements for your individual 
deployment may vary, but must meet the minimum requirements in Table 7.

Table 7. Requirements for Standard Interactivity and High Interactivity

Requirement Standard Interactivity High Interactivity

Must meet standard interactivity 
deployment requirements. (Supports 
standard browser settings.)

X

Must meet high interactivity general 
deployment requirements.

X

Must meet high interactivity ActiveX 
deployment requirements.

X

Must meet high interactivity Java 
deployment requirements.

X
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Standard Interactivity Deployment Requirements
This section describes in detail the standard interactivity deployment requirements 
summarized in “About Deployment Modes for Siebel Web Clients” on page 53.

Browser Requirements
Siebel eBusiness Applications running in standard interactivity mode are supported 
on most commonly used Web browser versions. End users must use a supported 
Web browser and version, as defined in System Requirements and Supported 
Platforms.

The browser must support the following technologies:

■ HTML 3.2 syntax.

■ JavaScript interpretation.

NOTE: If Siebel Reports Server is to be accessed from the application client, then 
cookies should be enabled for the browser. For more information, see “Using 
Cookies with Siebel Applications” on page 74.

Firewall Requirement
When deploying Siebel standard interactivity applications across a firewall, make 
sure that your firewall supports the HTTP 1.1 protocol.

High Interactivity Deployment—General Requirements
This section describes in detail the high interactivity general deployment 
requirements summarized in “About Deployment Modes for Siebel Web Clients” on 
page 53.

You can use the Microsoft Internet Explorer Administrator Kit and other system 
management tools to support high interactivity mode deployment requirements in 
supported versions of Internet Explorer. Customers should review the features of 
applicable deployment tools.
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Predefined Security Settings for Web Content Zones
Web content zones in Microsoft Internet Explorer support predefined security 
setting templates, or groups of settings: Low, Medium-low, Medium, and High.

You can use a zone such as Local intranet or Trusted sites for your Siebel 
applications and use the default security setting templates. Local intranet defaults 
to the Medium-low setting, and Trusted sites defaults to the Low setting. Siebel 
applications support both Low and Medium-low settings; Low is preferred.

■ To use the Local intranet zone, the Siebel eBusiness Applications URL must be 
hosted on the same intranet as the end users’ Web browsers.

■ To use the Trusted sites zone, the Siebel eBusiness Applications URL must be 
added as a site to the Trusted sites zone. 

Because Trusted sites are explicitly designated, lower security settings can 
generally be used than for other zones. For example, you can use the Trusted 
sites zone to allow end users to use ActiveX controls required for the Siebel 
application deployment, yet restrict end users from using ActiveX controls that 
may be associated with other sites.

Using security setting templates is preferred. If you do not use them, then you may 
need to adjust individual security settings for the applicable Web content zone. 
Some procedures in this chapter describe specifying (or verifying) custom settings, 
for customers who cannot use security setting templates. For more information, see 
“Manual Security Settings for High Interactivity” on page 69.

For more information about specifying Internet Explorer security settings or other 
settings, refer to Microsoft documentation.

Adjusting Printing Settings
To enable printing Siebel application screens using the browser’s Print command, 
Internet Explorer users must modify their printing settings.

To adjust printing settings

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Advanced tab.

3 Under Printing, select Print background colors and images.
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4 Click OK.

Bypassing Proxy Server for Local Addresses
If your network uses a proxy server, you should adjust your Internet Explorer 
browser settings to bypass the proxy server for local addresses. This setting provides 
better performance for all Siebel clients described in this book. For the Siebel Mobile 
or Dedicated Web Client, this setting is required.

To specify settings to bypass the proxy server for local addresses

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Connections tab, then click the LAN Settings button.

3 In the Proxy server section, verify whether the option Use a Proxy server for your 
LAN is enabled.

4 If the option Use a Proxy server for your LAN is enabled, check the box for 
Bypass proxy server for local addresses.

5 Click OK, then click OK again.

High Interactivity Deployment—ActiveX Requirements
This section describes in detail the ActiveX requirements for high interactivity 
deployment, noted in “About Deployment Modes for Siebel Web Clients” on 
page 53.

Siebel eBusiness Applications in high interactivity mode rely on ActiveX technology 
to deliver features such as interactive controls, keyboard accelerators, email client 
integration, and so on. For a list of the ActiveX download files (CAB files), see 
“ActiveX Controls Distributed for High Interactivity” on page 65.

A browser running a high interactivity application should be enabled to work with 
(download, instantiate and script) ActiveX controls. It is recommended that the URL 
for Siebel eBusiness Applications be part of a zone for which security settings are 
defined as described in this section.
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In addition, system administrators may need to modify permissions for users or 
applicable groups. For most deployments, downloading ActiveX controls on 
demand from a Web server is preferable: code for each control is downloaded to the 
Downloaded Program Files directory when the control is invoked for the first time 
by an application feature.

As noted in “ActiveX Controls Distributed for High Interactivity” on page 65, 
running some of these controls requires permission associated with Power Users.

The following methods are commonly used to meet the above requirements:

■ Modifying user groups or permissions in one of two alternative ways:

■ Adding users to the Power Users group

■ Relaxing default permissions granted to the Users group

■ Predeploying ActiveX controls for secure user permissions

How to implement each approach is described in the following sections.

Modifying User Groups or Permissions
This section describes two alternative ways of allowing users to download ActiveX 
controls. Use one of these methods.

Adding Users to the Power Users Group
End users on supported Microsoft Windows platforms require write access to the 
Downloaded Program Files directory and the Windows registry to allow automatic 
download and installation.

Typically, the Power Users or Administrators groups on supported Microsoft 
Windows platforms have the necessary permissions. The Users group, however, 
does not have these permissions. Consequently, putting your users in the Power 
Users group or Administrators group—or in a new user group with the appropriate 
permissions—will allow automatic download.

For more information on adding users to the Power Users group or other groups, 
review Microsoft operating system documentation.
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Relaxing Default Permissions Granted to the Users Group
Another approach is to grant all users the appropriate permissions by relaxing 
default permissions granted to the Users group. To do this, execute the following 
command (on one line) on supported Microsoft Windows platforms:

secedit /configure /cfg %windir%\security\templates\compatws.inf 
/db compat.sdb

More information on this issue can be found in the following Microsoft article:

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q269259

Predeploying ActiveX Controls for Secure Environments
If users on supported Microsoft Windows platforms are operating in secure 
environments and cannot obtain write access to the Downloaded Program Files 
directory through means described in the previous section, the ActiveX controls 
used for Siebel applications must be predeployed on these users’ machines.

The procedure that follows predeploys ActiveX controls by loading an HTML file 
similar to the example shown in “Example HTML File for Predeploying ActiveX 
Files” on page 63. The ActiveX controls you can deploy are those described in 
“ActiveX Controls Distributed for High Interactivity” on page 65.

NOTE: This task must be performed with the proper administrative permissions to 
install software on the client machine—usually Power Users or above.

To predeploy ActiveX controls

1 Navigate to the directory SIEBSRVR_ROOT\webmaster\build_number\applets, 
where SIEBSRVR_ROOT is the Siebel Server installation directory and 
build_number is the applicable build number. This directory contains the CAB 
files for the ActiveX controls you will deploy. 

NOTE: Optionally, you can create a different directory, and copy the CAB files to 
that directory. All remaining steps in this procedure refer to the location from 
which you will be deploying the ActiveX controls.
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2 Create a Web share for the directory specified in Step 1, such as the applets 
directory. Give this Web share read and execute permissions. (You may want to 
revert to more secure permissions after completing this procedure.)

The name of the Web share will be referenced in the URLs in the HTML file you 
edit in subsequent steps.

3 In the Web share directory, execute the following command to expand the CAB 
files:

expand *.cab Web_share_path

where Web_share_path is the complete path to the directory you specified as a 
Web share, such as applets. For each CAB file, a corresponding INF file is created 
in the Web share directory.

4 In the Web share directory, create an HTML file—for example, named 
predeploy.htm.

5 For each CAB file to be deployed, review its corresponding INF file. Review or 
edit the HTML file created in Step 4, to specify object tag values similar to those 
in “Example HTML File for Predeploying ActiveX Files” on page 63.

■ For the id attribute, you can use a name as shown in the example, the name 
of the INF file, or some other descriptive comment.

■ For the classid attribute, use the attribute identified in the INF file.

■ For the codebase attribute, use the URL location of the CAB file. In the 
example, localhost represents the machine name and applets represents the 
Web share directory. Use the CAB file names and version numbers as 
represented in the INF files.

You should have one object tag entry for each ActiveX control you are deploying. 
Delete any object tags you do not need.

6 Save the HTML file.

7 Remotely log into each client machine, then open the HTML file in Microsoft 
Internet Explorer. Wait until the message indicates that all the files have been 
downloaded, then close the browser and log off of the client machine.

8 Repeat Step 7 for each applicable user.
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Example HTML File for Predeploying ActiveX Files
The following is an example HTML file for predeploying ActiveX controls as 
described in the procedure above. Text in italics represents elements that may need 
to be modified for each object tag.

<html>

<head>

<meta http-equiv="Content-Type" content="text/html; 
charset=windows-1252">

<title>Predeployment Installer</title>

</head>

<body>

<p>

This page predeploys all Siebel ActiveX controls.  Please allow time 
for all ActiveX controls to be downloaded before closing this page.

</p>

</body>

<object 
id="SiebelOptionPack" 
classid="clsid:9d5f04cf-ef12-4ee5-8b30-8444b08c5500"
codebase="http://localhost/applets/
SiebelOptionPack.cab#version=7,5,3,16123">
</object>

<object 
id="siebelextmailclient" 
classid="clsid:1EEBFE70-1CE8-11D6-8C81-00D0B7E72554"
codebase="http://localhost/applets/
siebelextmailclient.cab#version=7,0,0,0">
</object>

<object 
id="csagent"
classid="clsid:DBFF771D-3F92-4C70-9978-508738536F38"
codebase="http://localhost/applets/csagent.cab#version=1,0,0,0">
</object>
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<object 
id="SiebelhtmlEditorLaunch" 
classid="clsid:727BEA23-42BE-4B46-9D2C-11521BF55940"
codebase="http://localhost/applets/
SiebelhtmlEditorLaunch.cab#version=1,0,0,0">
</object>

<object 
id="siebelhtml" 
classid="clsid:E06373B3-02C9-11D5-8BE8-00D0B7C0A3B1"
codebase="http://localhost/applets/
siebelhtml.cab#version=7,5,3,0">
</object>

<object 
id="subman" 
classid="clsid:06314967-EECF-11D2-9D64-0000949887BE"
codebase="http://localhost/applets/subman.cab#version=7,5,3,0">
</object>

</head>

<body>

<p>

The download is done you may close the window

</body>

</html>
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ActiveX Controls Distributed for High Interactivity
Table 8 lists the ActiveX controls distributed and used with Siebel Web clients. All 
of these controls are signed. 

NOTE: Depending on your Siebel software release, you may have only a subset of 
these CAB files.

Table 8. ActiveX Controls Used with Siebel Web Clients

Filename
Size in KB 
(Uncompressed) Control Name / Function

csagent.cab 57 Name: Siebel Communications Toolbar support for Sun 
JRE

Supports the communications toolbar (for Siebel CTI or 
other modules) when using Sun JRE.

siebelhtml.cab 73 Name: Siebel Web Client Automation Server

Supports client-side integrations your company may 
implement. (When this control is deployed, the 
EnableWebClientAutomation configuration 
parameter must be set to TRUE.)

Siebel Systems uses this control to support client-side 
email integration. See also the description for 
SiebExtMailClient.cab (Siebel Email Integration 
Control).

Note: Running this control requires the user to have the 
permissions associated with the Power Users group.

siebelhtmlEditorLaunch.cab 36 Name: Siebel Rich Text Editor

Supports the Siebel rich text editor (rich text control).

SiebelOptionPack.cab 1457 Name: Siebel HI Base Framework

Supports the Siebel high interactivity (HI) base 
framework.
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Uninstalling ActiveX Controls
If any ActiveX controls that have been downloaded to a user’s machine are no 
longer needed, you can uninstall them by deleting them from the Downloaded 
Program Files directory. 

If the user has permissions as described in “Modifying User Groups or Permissions” 
on page 60, applicable controls will be downloaded again as they are needed.

High Interactivity Deployment—Java Requirements
This section describes in detail the Java requirements for high interactivity 
deployment, noted in “About Deployment Modes for Siebel Web Clients” on 
page 53.

SiebExtMailClient.cab 305 Name: Siebel Email Integration Control

Supports client-side email integration (for Lotus Notes 
or Microsoft Outlook).

For more information about deploying this type of 
integration, refer to Siebel Communications Server 
Administration Guide.

Note: Deploying this control requires that you also 
deploy siebelhtml.cab (Siebel Web Client Automation 
Server).

subman.cab 77 Name: Siebel eBriefings offline content 
Synchronization

Supports Siebel eBriefings offline content 
synchronization.

Note: Running this control requires the user to have the 
permissions associated with the Power Users group.

Table 8. ActiveX Controls Used with Siebel Web Clients

Filename
Size in KB 
(Uncompressed) Control Name / Function
66 Siebel Web Client Administration Guide Version 7.5.3



Deploying Siebel Web Clients

High Interactivity Deployment—Java Requirements
A supported Java software environment is required to run a high interactivity client. 
Such an environment is also known as a Java Virtual Machine (JVM) or Java 
Runtime Environment (JRE). Siebel applications support the following Java 
environments:

■ Microsoft Java Virtual Machine (JVM)

■ Sun Java Runtime Environment (JRE)

Supported JVM/JRE versions are outlined in System Requirements and Supported 
Platforms. Choose the appropriate JVM/JRE based on compatibility requirements 
with existing applications as well as on availability.

For a list of the Java download files, see “Java Applets Distributed for High 
Interactivity” on page 68.

The message bar, communications toolbar, and Business Process Designer are 
examples of Siebel product features that require Java functionality, depending on 
Siebel release and configuration.

Specifying the Java Software Environment
This section describes the two alternative Java software environments supported for 
Siebel applications.

Specifying Microsoft Java Virtual Machine (JVM)
If Microsoft JVM is installed and no other Java environment is installed, then it is 
already configured as the default Java environment, and you do not need to do 
anything else.

However, if you also have Sun JRE installed, you may need to modify security 
settings to specify Microsoft JVM as the default. For details, see “Manual Security 
Settings for High Interactivity” on page 69.

To use Sun JRE, you must specify it as the default, as described below.
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Specifying Sun Java Runtime Environment (JRE)
To enable Siebel high interactivity applications to use Sun Java Runtime 
Environment (JRE), you must specify Sun JRE as the default Java environment in 
the browser. Another JVM or JRE product may also be installed, but Sun JRE should 
be enabled as the default.

To specify settings for Sun JRE

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Advanced tab.

3 In Settings, under Java (Sun), check Enable Java xxxx (where xxxx represents 
the version number for Sun JRE).

4 Click OK.

Java Applets Distributed for High Interactivity
Table 9 lists the Java applets distributed and used with Siebel Web clients. All of 
these controls are signed, except where noted.

Table 9. Java Applets Used with Siebel Web Clients

Filename
Size in KB 
(Uncompressed) Feature / Function

SiebelFlowChart.cab 150 Design of SmartScripts, organization charts, workflow 
rules.

SiebelFunnelChart.cab 80 Constructs sales and sales-phases pipeline analysis 
charts.

SiebelLocale.cab 122 Locale features (date, time, currency).

Note: This Java applet is unsigned by default.

SiebelMarketingEditor.cab 116 Marketing campaign designer.

SiebelMenu.cab 57 Application-level menus.

SiebelRulesDesigner.cab 67 Personalization business rules designer.
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Manual Security Settings for High Interactivity
If you are not using supported security setting templates for applicable Web content 
zones for your Siebel high interactivity applications, then you must manually 
specify the Internet Explorer settings described in this section. 

See also “High Interactivity Deployment—General Requirements” on page 57 and 
following sections.

Manual Settings for ActiveX Controls and Plugins
To enable full functionality related to ActiveX controls and plugins for Siebel 
applications in high interactivity mode, specify the following settings.

For more information, see “High Interactivity Deployment—ActiveX Requirements” 
on page 59.

To specify ActiveX settings

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Security tab.

3 Select the Web content zone you want to customize (for example, Local intranet 
or Trusted sites).

4 Click Custom Level.

5 In Security Settings, under ActiveX Controls and Plug-ins > Download Signed 
ActiveX Controls, select Enable or Prompt.

SiebelToolbar.cab 119 Communications toolbar (for Siebel CTI or related 
modules) and scrolling message bar.

SiebelShared.cab 27 Shared requirement for Java features above.

Table 9. Java Applets Used with Siebel Web Clients

Filename
Size in KB 
(Uncompressed) Feature / Function
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6 In Security Settings, under ActiveX Controls and Plug-ins > Run ActiveX 
Controls and Plug-ins, select Enable.

7 In Security Settings, under ActiveX Controls and Plug-ins > Script ActiveX 
Controls marked safe for scripting, select Enable.

8 Click OK, then click OK again.

Manual Settings for Scripting
To enable full functionality related to scripting for Siebel applications in high 
interactivity mode, specify the following settings.

Scripting is used in the high interactivity framework to manage data-only 
interactions with the server and to interact with the browser DOM, ActiveX controls, 
Java applets, and so on. The high interactivity framework also supports browser 
scripting for data validations.

To specify scripting settings

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Security tab.

3 Select the Web content zone you want to customize (for example, Local intranet 
or Trusted sites).

4 Click Custom Level.

5 In Security Settings, under Miscellaneous > Active Scripting, select Enable or 
Prompt.

6 In Security Settings, under Miscellaneous > Scripting of Java Applets, select 
Enable or Prompt.

7 Click OK, then click OK again.

Manual Settings for Downloads
To enable full functionality related to attachments and file import and export for 
Siebel applications in high interactivity mode, specify the following settings.
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To specify download settings

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Security tab.

3 Select the Web content zone you want to customize (for example, Local intranet 
or Trusted sites).

4 Click Custom Level.

5 In Security Settings, under Downloads > File Download, select Enable.

6 Click OK, then click OK again.

Manual Settings for Microsoft Java Virtual Machine
If Microsoft Java Virtual Machine (JVM) is installed and no other Java environment 
is installed, then it is the default Java environment, unless another module such as 
Sun JRE is already installed and specified as the default. If you are not using security 
setting templates, and you have Sun JRE installed, follow the steps below to make 
sure that Microsoft JVM is the default Java environment.

For more information, see “High Interactivity Deployment—Java Requirements” on 
page 66.

To specify settings for Microsoft JVM

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Security tab.

3 Select the Web content zone you want to customize (for example, Local intranet 
or Trusted sites).

4 Click Custom Level.

5 In Security Settings, under Microsoft VM > Java Permissions, select Medium 
safety or Low safety.

This security setting is automatically applied with the Medium-low or Low 
security template for the applicable Web content zone.
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6 If Sun JRE is also installed on the machine: Click the Advanced tab. In Settings, 
under Java (Sun), verify that Enable Java xxxx is not checked (where xxxx 
represents the version number for Sun JRE).

In other words, if you intend to use Microsoft JVM, make sure that Sun JRE is 
not enabled.

7 Click OK.

Manual Settings for IFRAME Support
Siebel Web templates are configured to use IFRAME elements. To enable IFRAME 
support in your browser, follow the steps described below.

For more information about IFRAME support, consult your browser documentation.

To enable support for IFRAME elements

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Security tab.

3 Select the Web content zone you want to customize (for example, Local intranet 
or Trusted sites).

4 Click Custom Level.

5 In Security Settings, under Miscellaneous > Launching programs and files in an 
IFRAME, select Enable or Prompt. (Enable is recommended.)

6 Click OK, then click OK again.

Other Deployment Options for High Interactivity
This section describes several additional browser deployment settings and issues for 
Siebel high interactivity applications. 
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See also “Using Cookies with Siebel Applications” on page 74.

NOTE: Settings described in this section are optional in most cases. The applicability 
of these sections varies according to your overall deployment environment.

Using Secure Sockets Layer (SSL)
If you are using Secure Sockets Layer (SSL) between the Web server and the Web 
browser with any high interactivity mode application, the following message may 
appear: 

This page contains both Secure and Non Secure items. Do you want 
to download non secure items?

This prompt may be misleading, because, despite the wording of this message, 
Siebel application requests will be processed on HTTPS, not HTTP. The prompt can 
optionally be suppressed.

For more information about using Secure Sockets Layer with Siebel applications, 
refer to Security Guide for Siebel eBusiness Applications.

To suppress the prompt for secure and non-secure items

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Security tab.

3 Select the Web content zone you want to customize (for example, Local intranet 
or Trusted sites).

4 Click Custom Level.

5 In Security Settings, under Miscellaneous > Display mixed content, select 
Enable.

6 Click OK, then click OK again.
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Deploying Siebel Applications Accessed Through a Firewall
When deploying Siebel high interactivity applications across a firewall, verify that 
your firewall supports the HTTP 1.1 protocol. If your firewall does not support 
HTTP 1.1 protocol, the browser setting to disable this protocol for proxy 
connections should be specified.

To disable using HTTP 1.1 through a proxy

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Advanced tab.

3 Under HTTP 1.1 settings, uncheck Use HTTP 1.1 through proxy connections.

4 Click OK.

Disabling Script Debugging
Script debugging is typically automatically enabled by Microsoft Visual Studio 
products. To improve performance of the Web browser for use with Siebel 
applications, you must disable script debugging in the Internet Explorer browser.

To disable script debugging

1 In Internet Explorer, choose Tools > Internet Options.

2 Click the Advanced tab.

3 Under Browsing, check Disable script debugging.

4 Click OK.

Using Cookies with Siebel Applications
Siebel applications running in the Web browser can optionally use cookies for a 
variety of purposes.

NOTE: Unless otherwise noted, all of the cookies described in this section apply to 
both high interactivity and standard interactivity applications.
74 Siebel Web Client Administration Guide Version 7.5.3



Deploying Siebel Web Clients

Using Cookies with Siebel Applications
All cookies used by Siebel applications are encrypted using standard encryption 
algorithms provided by RSA.

For information about enabling cookies in the Microsoft Internet Explorer Web 
browser, see “Enabling Cookies for Siebel Applications” on page 77.

Siebel applications use the following kinds of cookies:

■ Session cookie. Manages user sessions. For details, see “Session Cookie” on 
page 75.

■ Auto-login credential cookie. Stores user credentials. For details, see “Auto-Login 
Credential Cookie” on page 77.

■ Siebel QuickStart cookie. This cookie is created for the Mobile Web Client when 
Siebel QuickStart is used. This Siebel client supports employee applications in 
high interactivity mode only. The Siebel QuickStart cookie, named 
siebel.local.client, is persistent and does not contain Siebel session ID data.

For more information, see “Siebel Mobile Web Client and Siebel QuickStart” on 
page 91.

■ Siebel Reports Server cookie. Contains the user’s Siebel login name and an auto-
generated password. This cookie is sent by the Siebel Web Server to the browser, 
and must be enabled in order for the user’s Siebel client to connect to the 
Reports Server (in single sign-on fashion). The Reports Server cookie, named 
ReportCookie, is non-persistent and does not contain Siebel session ID data.

For more information about administering Siebel Reports, refer to Siebel Reports 
Administration Guide.

Session Cookie
The session cookie consists of the session ID generated for a user’s session. This 
cookie is used to manage the user position in the session. This cookie applies to the 
Siebel Web Client only.

The Siebel application can run in either cookie-based mode or cookieless mode. Use 
cookieless mode if a particular browser does not support cookies.
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■ Cookie-based mode. When a user successfully logs into the application, a unique 
session ID is generated. The components of the session ID are generated in the 
Siebel Server and sent to the Session Manager running in the Siebel Web Server 
Extension. In cookie-based mode, the session ID is passed to the user’s browser 
in the form of a non-persistent cookie.

Session ID components include the applicable server ID, process ID, and task ID, 
combined with a timestamp. All values are in hexadecimal form, as shown:

server_ID.process_ID.task_ID.timestamp

For example, the session ID may resemble this:

sn=!1.132.6024.3ca46b0a

The session ID is encrypted in the cookie if the EncryptSessionId parameter 
is set to TRUE in the eapps.cfg file. Encrypting the session ID prevents 
unauthorized attackers from capturing the cookie and determining its format.

The session cookie is non-persistent and is stored in memory only. It stays in the 
browser for the duration of the session, and is deleted when the user logs out or 
is timed out.

For every application request that the user makes during the session, the cookie 
is passed to the Web server in an HTTP header as part of the request. Without 
a valid cookie in the HTTP header, the Web server will not honor that request.

■ Cookieless mode. By default, Siebel applications use session cookies. However, if 
the user’s browser does not support or allow the use of cookies, the session 
automatically uses cookieless mode.

In cookieless mode, the session ID is passed as an argument in the SWE 
construct of the URL. Any URL request passed to the Web server from the 
browser must include a valid session ID, or it will be rejected by the Web server. 

The session ID in the URL is encrypted if the EncryptSessionId parameter is 
set to TRUE in the eapps.cfg file.

The Siebel application can be configured to not use cookies for session 
management—that is, it can be set to operate in cookieless mode at all times. 
For more information, see Siebel Server Installation Guide and Security Guide for 
Siebel eBusiness Applications.
76 Siebel Web Client Administration Guide Version 7.5.3



Deploying Siebel Web Clients

Using Cookies with Siebel Applications
Auto-Login Credential Cookie
The auto-login credential cookie consists of the username and password for a given 
user, and the URL string used to access the application. The auto-login credential 
cookie is persistent and is stored on the user’s browser in encrypted form (it is 
always encrypted). This cookie applies to the Siebel Web Client only.

The auto-login credential cookie is not mandatory. It is an optional way to allow 
users not to have to enter their username and password every time they log in.

Enabling Cookies for Siebel Applications
This section describes how to enable the Microsoft Internet Explorer Web browser 
to handle cookies used by Siebel applications.

Review instructions for your supported browser version.

To enable cookies using Internet Explorer 5.5

1 Choose Tools > Internet Options.

2 Click the Security tab.

3 In Security settings, under Allow cookies that are stored on your computer, 
select Enable or Prompt.

This setting enables persistently storing the auto-login credential cookie and, for 
the Mobile Web Client, the Siebel QuickStart cookie.

4 In Security settings, under Allow per-session cookies (not stored), select Enable 
or Prompt.

This setting enables storing the session cookie and the Siebel Reports Server 
cookie during the length of the session.

5 Click OK, then click OK again.

To enable cookies using Internet Explorer 6.0

1 Choose Tools > Internet Options.

2 Click the Privacy tab.

3 In Privacy settings, click Advanced.
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4 Verify that Override automatic cookie handling is checked. Also consider:

■ If First-party Cookies is set to Accept, then all Siebel cookies are enabled.

■ If First-party Cookies are blocked, you can still enable the session cookie or 
the Reports Server cookie by checking Always allow session cookies.

5 Click OK, then click OK again.
78 Siebel Web Client Administration Guide Version 7.5.3



Configuring and Using Mobile Web Client 4
This chapter provides instructions for:

■ Configuring the Mobile Web Client and connecting to the Siebel Remote Server

■ Troubleshooting the Mobile Web Client

■ Synchronizing using Siebel Remote

■ Using the Siebel QuickStart agent with the Mobile Web Client

For more information about Siebel Remote and about extracting local databases for 
mobile users, see Siebel Remote and Replication Manager Administration Guide. See 
also System Requirements and Supported Platforms.

Setting Up and Connecting to the Siebel Remote Server
The Siebel Remote Server runs the Siebel Remote components and manages 
synchronization sessions with Mobile Web Clients. The Siebel Remote Server 
provides an interim storage area for data required to synchronize the mobile 
databases with the Siebel Database. 

Siebel Remote clients must be able to connect to the Siebel Remote Server using 
TCP/IP. Verify that the correct hardware and software is installed on each client 
machine and that TCP/IP connectivity to the Siebel Remote Server is established.

Mobile Web Client Configuration Parameters
The Siebel Remote client reads parameters in the Siebel configuration file, such as 
siebel.cfg for Siebel Sales, to specify the location of the Siebel Server directories, 
Siebel File Server directories, and the Siebel Database installation. Before using 
Siebel Remote, you must set the values for the configuration parameters.

For more information on configuration parameters, see Appendix A, “Configuration 
Parameters.”
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For information on event logging, see Siebel Server Administration Guide.

Set the following parameters in the [Siebel] section of the configuration file:

■ ClientRootDir. Name of the Siebel client installation directory.

■ DockRepositoryName. Name of the Siebel Repository that you are currently using. 
This parameter must have the same value as the Siebel Server repository.

Set the following parameters in the [Local] section of the configuration file:

■ DockConnString. Logical network address of the Siebel Server to which you want 
to connect for synchronization.

It is recommended that every synchronization session occur within the 
corporate firewall. If your deployment must support synchronization through 
the Internet from outside the firewall, VPN is a good alternative. If this is the 
environment you are using, then the port for synchronizing with your server 
must be opened on your firewall. Also make sure your Internet service provider 
(ISP) does not block communication to this particular port. 

This parameter has the following format:

siebel_server_name:network_protocol:sync_port_#:
service:encryption:compression 

where:

■ siebel_server_name = The logical network address of the Siebel Server to 
which you want to connect for synchronization.

■ network_protocol = The name of the networking protocol to use. TCPIP is 
the only valid value and is the default value if nothing is specified.
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■ sync_port_# = The TCP/IP port number dedicated to the Synchronization 
Manager. The default value is 40400 if nothing is specified.

NOTE: You can use the Server Administration screen to override the default 
value. To do this, specify a value for the Synchronization Manager 
(SynchMgr) component’s SyncPort parameter, and restart the Siebel Server. 
You can also specify this port number as a command-line option when 
starting the Siebel Server. If you change this value, also update the 
configuration file on the client so it matches the server settings.

■ service = The TCP/IP service you are requesting. SMI is the only valid 
value and is the default value if nothing is specified.

■ encryption = The encryption package you are using. The encryption 
facility must match the type used by the server. Both MSCrypto and RSA are 
supported. 

All elements except the Siebel Server name are optional. If an item between 
other items is omitted, adjacent colons must be retained—as in the third 
example below, which omits the network protocol element. Examples of valid 
values for DockConnString are:

❏ SIEBAPP1

❏ SIEBAPP1:TCPIP:9000

❏ SIEBAPP1::9000

❏ SIEBAPP1:TCPIP:40400:SMI:RSA

■ DockTxnsPerCommit. Number of transactions that Siebel Remote applies to the 
local database before performing a commit. You should set this parameter to a 
value that satisfies the needs at your site. The default is 500.

■ If you are using the Siebel Mobile Web Client to dock, set 
DockTxnsPerCommit to a high value. Merged transactions will not lock out 
other users. This enhances the performance of Siebel Remote.
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■ If you are using the stand-alone synchronizer, set DockTxnsPerCommit to a 
high value only if the program will be the only active user on the database. 
If the program will apply transactions while the user is accessing the 
database through the application, set a low value to prevent locking out other 
users while merging transactions. 

■ TableOwner. Name of the database account on the local database where the 
Siebel schema is installed. Default is SIEBEL.

Troubleshooting Mobile Web Client and Siebel Remote
This section describes some system failures that may affect Siebel Mobile Web 
Client users, and describes how to recover from them or avoid them.

NOTE: Depending on the kind of failure experienced, database changes and file 
attachments that were awaiting upload during the next synchronization session 
may be lost. The user may need to reenter these transactions and file attachments.

Communication System and Hardware Failures
Noisy or faulty communication lines may lead to communication errors within the 
Siebel Remote synchronization process. If an error is detected, Siebel Remote has 
built-in fault-tolerance features that continue to retransmit files in an attempt to 
synchronize successfully.

Hardware or Media Failure
If a local SQL Anywhere database becomes unusable because of a hardware or 
media failure, you must refresh the local database. To do this, run Database Extract 
for the client.

Make sure that client machines always operate with sufficient power, particularly 
when synchronizing, to minimize the risk of database corruption problems relating 
to power loss.
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User Synchronization Options for Mobile Web Client
This section describes user synchronization options supported by Siebel Remote 
and Siebel Mobile Web Client. 

Users access synchronization options by doing either of the following:

■ Selecting File > Synchronize > Database from the application-level menus in 
the Siebel application.

■ Starting Siebel Remote in stand-alone mode. The stand-alone synchronization 
feature allows mobile users to synchronize their local databases with the server 
database without starting the Siebel application.

Synchronization occurs in the background, so you can continue to use Siebel 
applications during synchronization.

The auto-synchronization option for running Siebel Remote in stand-alone mode 
helps maintain the frequency of synchronization. After initializing their local 
databases, mobile users enable or disable auto-synchronization by choosing View 
> User Preferences > DB Synchronization. For more information, see “Using Auto-
Synchronization” on page 88.

Synchronization Dialog Box
The Siebel Remote synchronization dialog box shown in Figure 2 contains a list of 
synchronization actions.
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Depending on your database options, the list may appear different from that in the 
example. For instance, if you do not have a local database, the dialog box may 
contain only the Connect to Server action.

Synchronization Actions
This section describes the available synchronization actions in the Siebel Remote 
synchronization dialog box.

■ Connect to server. Connects to the server, dials the phone number if necessary, 
and performs version, schema, and database initialization checking. If a Local 
Database Initialization (dbinit) or upgrade is pending, this action downloads 
and applies the pending Local Database Initialization or upgrade.

This action must run successfully for the following three actions to be invoked: 
Send database changes, Retrieve database changes, and Retrieve requested files.

■ Send database changes. Sends the local transactions to the server by sending one 
or more DX files and associated attachment files to the server. This action 
displays the number of transactions that still need to be sent.

■ Retrieve database changes. Retrieves transactions from the server by retrieving 
one or more DX transaction files and associated attachment files from the server. 
These files are generated by the Transaction Router on the Siebel Remote Server. 
This action displays the number of transactions that still need to be retrieved.

Figure 2. Siebel Remote Synchronization Dialog Box
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■ Retrieve requested files. Retrieves user-requested attachment files from the server. 
This action displays the number of files that still need to be retrieved.

■ Apply database changes. Applies database changes retrieved from the server to 
the local database. This action displays the number of transactions that still need 
to be applied.

Synchronization Action States
In the Siebel Remote synchronization dialog box, you can enable or disable each 
action by checking the check box to the left of the action. Explanations of the 
possible check box states are shown below:

While an action is running, you can click the check box for the action to disable it 
before the action has finished. If an action is running when you disable it, it stops 
as soon as possible, and synchronization continues with the next action.

The action status check boxes persist throughout the session. If you start 
synchronization with the option Apply database changes disabled, it remains 
disabled throughout synchronization. If you restart Siebel applications, the action 
status check boxes return to their default state (enabled).

Enabled. This action will run when its turn comes.

Disabled. This action will not run when its turn comes.

Not runnable. This action cannot run because an action it depends upon 
did not (or will not) run.

Finished. This action is finished.

Skipped. This action was skipped.
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Item Status Field
The word pausing appears in the Item Status field. Actions are made up of one or 
more items and may be hidden. The items (and sub-items) that appear in this field 
update the synchronization status for the user. Below the Item Status field is the 
item progress indicator, which indicates the remaining processing time for the item.

NOTE: The progress indicator provides reasonably accurate time estimates for long-
running items, such as transferring files or merging transactions, but less accurate 
estimates for short-running items, such as connecting to the server or database.

Skip File Button
The Skip File button is enabled whenever synchronization is performing an item or 
sub-item that is not critical to the current action. Retrieving an optional attachment 
file is the only action that can be skipped. Clicking this button skips the current item 
or sub-item, and the current action continues. Double-clicking this button generates 
a prompt and skips all remaining optional items for this action.

Overall Transfer Progress Panel
This panel appears when communications with the server are active. The progress 
indicator displays the progress toward completing the actions that require the 
communications line.

Transfer Time Remaining Field
This field contains the estimated time for completing the actions.

NOTE: The estimated time may be inaccurate when large attachment files are 
transferred.

Synchronize/Stop Command Button
The Synchronize button starts synchronization. You can click this button even while 
synchronization is still performing hidden actions, such as connecting to the local 
database and extracting local database changes. When you click this button, the 
synchronization dialog box is hidden (unless SHIFT is held down), and the label on 
the button changes to Stop. 
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Clicking the button again (Stop) stops synchronization if it is still running. When 
synchronization finishes, the button changes to OK. Clicking the button again hides 
the synchronization dialog box. 

If the dialog box is hidden while synchronization is running, invoking 
synchronization redisplays the dialog box. If synchronization is finished, invoking 
synchronization resets and redisplays the dialog box.

Cancel/Hide Button
Clicking the Synchronize button automatically hides the synchronization dialog 
box, unless you hold down SHIFT when you click the button. If the dialog box is 
hidden, you can redisplay it by clicking the corresponding icon in the system tray.

If the synchronization dialog box is displayed:

■ If synchronization has not started, clicking Cancel closes the synchronization 
dialog box and aborts synchronization.

■ If synchronization has started, the label on this button changes to Hide. Clicking 
this button hides the synchronization dialog box.

Setup Button
Clicking the Setup button displays the Docking Preferences dialog box. The two File 
options control which files to synchronize. File options can be changed while 
synchronization is running.

■ Retrieve Published Files Box. When this check box is selected, synchronization 
retrieves all newly published files.
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■ Retrieve Auto Update Files Box. If this check box is selected, synchronization 
retrieves updates to local files marked for auto-update. Auto-update files that are 
not local or have not been requested are not retrieved. 

The auto-update flag is local to each node, so users can choose to update files 
automatically, without affecting other users. If you do not choose the Retrieve 
Auto Update Files option during this synchronization session, then 
synchronization marks the files that need to be updated. Synchronization then 
makes all auto-update files current during the next session, when Retrieve Auto 
Update Files is enabled.

When the Mobile Web Client receives a transaction on a file table, 
synchronization decides whether to retrieve the file locally. The default is not to 
download files to the Mobile Web Client unless the file is requested. File screens 
generally have a request field that users can select to download the file during 
the next docking session (if the Retrieve Requested Files action is enabled). Files 
are also uploaded to the server by docking.

If you change a file, you must upload the new file with the transaction to make 
the corporate database consistent. These files are stored near the corporate 
database on a file server. Name files carefully to avoid conflicts, such as two 
users attempting to modify a file at the same time.

■ Dial-up Networking Connection. The Connection box allows users to select a dial-
up networking connection. Leaving the box blank causes synchronization to use 
an existing network connection. Changes to the dial-up networking options 
takes effect the next time synchronization makes a connection to the server.

■ Auto-Start Siebel Remote Box. If this check box is selected, Siebel Remote begins 
synchronization as soon as you invoke synchronization. The Siebel Remote 
synchronization dialog box is not displayed. If you want to display the dialog 
box throughout your session, press SHIFT when you click Start.

Using Auto-Synchronization
Auto-synchronization increases the frequency of synchronization sessions, thereby 
decreasing the volume of transactions for each session and shortening the average 
connect time.

The Auto-Synchronization Agent runs in the background at scheduled times to 
perform automatic synchronization when the user is connected to the network.
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Follow the procedure below to invoke auto-synchronization and the available 
options. One of the options is a synchronization reminder that prompts the user to 
synchronize if a specified period passes without a synchronization session.

The Siebel Autosync shortcut is installed in the Startup folder when the Siebel client 
is installed. This enables the Auto-Synchronization Agent to be launched when the 
Windows session is started.

NOTE: Auto-synchronization can be enabled only if a local database exists on the 
client machine.

To enable auto-synchronization

1 Verify that the local database is initialized.

2 Log into the local database, and navigate to View > User Preferences > 
DB Synchronization.

3 Choose one of the available Auto-Synchronization options listed in Table 10.

Table 10. Auto-Synchronization Options

Option Description

Enable Auto-Synchronization 
check box

Required to enable auto-synchronization.

User Confirmation check box Optional.

Maximum Retries picklist Defaults to zero, but recommend 2 or 3.

Maximum Network Latency 
picklist

Required. Sets a network latency that will prevent the 
auto-synchronization agent from invoking a 
synchronization session. The administrator 
establishes this policy. For example, at 56 KB, the 
threshold may be 200–300 milliseconds or higher. 
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4 Specify a value for the Synchronization Frequency picklist, as listed in Table 11, 
then complete other relevant options in this section.

5 In the Synchronization Reminder form, check or pick the following:

■ Enable Synchronization Reminder. Appears when the Mobile Web Client is 
running, and if the last synchronization was earlier than the minimum days 
between synchronization sessions.

Reminds the user to perform synchronization by displaying the message 
“Perform database synchronization now?” Respond accordingly.

Table 11. Synchronization Frequency Options

Option Description

Default Default is Empty. Same behavior as if auto-synchronization is 
disabled.

System boot up Perform the next synchronization after the computer is 
started and operational. If no network connection is 
available, try again the next time the computer is rebooted.

Mobile Client Start up Perform synchronization after the Mobile Web Client is 
started. If no network connection is available, try again the 
next time the client is started.

Hourly Perform synchronization every hour at the specified time 
increment chosen in the Hourly At picklist. If the computer is 
not operational at the specified time, then perform the 
synchronization at the scheduled time.

Daily Perform synchronization every day at the specified time 
entered in the Daily At field. If the computer is not 
operational at the specified hour, then perform the 
synchronization at the earliest time when the machine is 
operational.

Weekly Perform synchronization every week on the specified day 
chosen in the Weekly On picklist, and at the specified time 
entered in the Weekly At field. If the computer is not 
operational at the specified time, then perform the 
synchronization at the earliest time when the machine is 
operational.
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■ Min Days Between Sync Sessions. Specifies the minimum number of days 
between synchronization sessions.

Siebel Mobile Web Client and Siebel QuickStart
Siebel QuickStart is an agent that is preloaded on a mobile user’s machine at startup 
and reduces the time required to launch the Siebel Mobile Web Client.

NOTE: Siebel QuickStart can be used with the Siebel Mobile Web Client only, when 
connecting to the local database or Sample Database. It does not apply to Siebel 
Dedicated Web Client or Siebel Web Client.

Siebel QuickStart is enabled and loaded for the first time from the Siebel application 
login screen.

Siebel QuickStart applies to subsequent instances of the same type of Siebel 
application session—running the same application as the same user and with the 
same startup options. The speed increase provided by QuickStart does not take 
effect on the initial Siebel login. Subsequent logins of the same type of Siebel 
application session benefit from QuickStart, until the user disables QuickStart. 

Siebel QuickStart stores the encrypted Siebel user name and password in the 
siebel.local.client cookie. For additional information about using cookies with 
Siebel applications, see “Using Cookies with Siebel Applications” on page 74.

NOTE: Users should disable Siebel QuickStart for existing application sessions before 
enabling it for another application session.

Enabling and Disabling Siebel QuickStart

To enable Siebel QuickStart

1 Start a Siebel application with the Mobile Web Client. For example, double-click 
the shortcut for Siebel Call Center for your applicable language.
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2 In the Siebel login screen, check the Enable Siebel QuickStart check box.

The QuickStart agent is loaded into memory for the rest of the Microsoft 
Windows session, and is loaded again when the user logs into Windows 
subsequently, unless the user disables it.

To disable Siebel QuickStart from the login screen

1 Start a Siebel application with the Mobile Web Client. For example, double-click 
the shortcut for Siebel Call Center for your applicable language.

2 In the Siebel login screen, clear the Enable Siebel QuickStart check box, if it is 
checked.

The QuickStart agent is not loaded for this Siebel application session, and does 
not load subsequently unless it is explicitly specified.

To disable Siebel QuickStart from the system tray

■ Right-click the Siebel icon in the system tray and select Disable On Startup. 

If the Siebel application is not running, the QuickStart agent exits. The agent 
does not load subsequently unless it is explicitly specified.

If the Siebel application is running, the QuickStart agent stays loaded until you 
log out of the Siebel application session. The agent does not load subsequently 
unless it is explicitly specified.

Options for Siebel Icon in the System Tray
When the Siebel application is running or the QuickStart agent is loaded, an icon 
appears in the system tray. Right-clicking this icon displays several choices:

■ Exit. Exits the QuickStart agent for the current Windows session. This option is 
available only when the QuickStart agent is loaded and the Siebel application is 
not running. If QuickStart is enabled, the agent loads again the next time the 
user starts the Siebel application the same way, or starts Windows.

■ Disable On Startup. Disables Siebel QuickStart the next time the user starts the 
Siebel application or starts Windows. Also exits the QuickStart agent, in the 
manner described in the previous section. This option is available only when the 
QuickStart agent is loaded, whether or not the Siebel application is running.
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■ About. Displays information about Siebel applications. This option is available 
when the Siebel application or the QuickStart agent are running, or both.

■ Help. Displays Siebel Online Help. This option is available when the Siebel 
application or the QuickStart agent are running, or both.

Using View Precaching with Siebel QuickStart
When the QuickStart agent is loaded, views specified using the parameters in the 
[Preload] section of the configuration file, such as siebel.cfg, are preloaded 
(precached) during startup of the Siebel application. In subsequent application 
sessions, navigating to a precached view is faster.

In the [Preload] section, specify the names of the views to be precached as the 
values for configuration parameters named View1, View2, and so on.

For more information about specifying configuration file parameters, see 
Appendix A, “Configuration Parameters.”

Specifying QuickStart Availability with Siebel Packager
By default, the siebel.exe program has Siebel QuickStart available. However, 
administrators may choose to package client installations with QuickStart 
unavailable—so the Enable Siebel QuickStart check box does not appear on the 
Siebel login screen and thus cannot be enabled by end users.

When preparing model Siebel client installations to include in packages you create 
using the Siebel Packager utility, you can disable Siebel QuickStart. To do this, 
rename or remove the siebel.exe program and then change the name of siebel1.exe 
to siebel.exe.

For more information on using the Packager utility, see Chapter 5, “Using Siebel 
Packager Utility.”

QuickStart and AutoStopDB Configuration Parameter
When you are using Siebel QuickStart, you may also decide to set the configuration 
parameter AutoStopDB to FALSE for the local database. Both of these features have 
a similar performance benefit when the Siebel application is started and exited 
multiple times within the same Windows session.
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For more information about the AutoStopDB parameter, see “Data Source 
Parameters” on page 134.
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The Siebel Packager utility allows the Siebel administrator to assemble the Siebel 
client executable program and other installed files, including your custom 
configuration, into a customized installation package that is tailored to your needs. 
Siebel Packager packages installations for Siebel Mobile or Dedicated Web Client.

Siebel administrators can use these installation packages when installing Siebel 
eBusiness Applications for the first time or when upgrading from a previous 
version. Optionally, you can package the Siebel client installation as a single, self-
extracting archive file.

Ways to Distribute Siebel Client Packages
After the Siebel client installation has been packaged, the package can be 
distributed to your users in several ways. For details, see “Making Your Customized 
Installer Available to End Users” on page 104.

■ Siebel Anywhere. Distribute and execute the package automatically as a Siebel 
Anywhere kit. 

■ CD-ROM. Distribute the package to end users on CD-ROMs.

■ LAN, WAN, VPN, or modem. Distribute the package across a LAN, WAN, VPN, or 
modem. Do this directly or using third-party software.

■ Other methods. Distribute the package by email or FTP to end users.

General Process of Creating a Package
The Packager utility creates a standard installation package in two steps:

1 Gathers the Siebel components and files you specify, copies the standard 
InstallShield components into the client installer directory, and creates a packing 
list used by InstallShield.
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2 (Optional.) Packages the Siebel client installer (prepared in the previous step) 
into a self-extracting archive, which, when executed, automatically 
decompresses and starts the Siebel client installer.

Preparing to Use the Siebel Packager Utility
Before using the Packager utility, follow the steps in this section.

For instructions on installing Siebel clients, see Chapter 2, “Installing Mobile and 
Dedicated Web Clients.”

NOTE: This chapter refers to the Siebel client installation directory, such as 
C:\sea752\client, as SIEBEL_CLIENT_ROOT.

To prepare to use the Packager utility

1 Perform a Siebel client installation on the computer on which you will run the 
Packager utility.

The Packager uses the files from this model client installation (or another client 
installation, as specified when running the Packager) in creating the installation 
package.

During Siebel client installation, select Typical, or select Custom and make sure 
to select the Packager Utility option.

NOTE: If two Siebel clients are installed on the same computer, where one is used 
as a Mobile Web Client and the other is a master installation for Packager, make 
sure to exit the SQL Anywhere engine before running Packager. An installation 
that has an initialized local database should never be used as a master 
installation for creating packages.
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2 Customize the model Siebel client installation so that it is identical to how you 
intend to package it. When you create the custom installer, the Packager utility 
reproduces this model installation.

If you have custom Siebel repository (.srf) or configuration (.cfg) files, report 
files, Web templates, or other changes or additions, copy them to the appropriate 
subdirectories under SIEBEL_CLIENT_ROOT, or under the root directory of 
another installation that you will use to create the custom installation package.

NOTE: The Packager utility can package only those files that reside in the 
SIEBEL_CLIENT_ROOT directory. 

3 Make sure that you have sufficient free disk space on the computer on which 
you are installing the Packager utility and will create packages.

During the packaging process, the Packager utility temporarily requires at least:

■ Three times the amount of disk space required by the Siebel Mobile and 
Dedicated Web Client software you are packaging, and

■ Twice the disk space required by the third-party software (provided with the 
Siebel eBusiness Applications) that you are packaging.
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Siebel Modules for Packaging
The Siebel Mobile or Dedicated Web Client consists of the installable modules 
described in Table 12. These modules correspond to the subdirectories under the 
SIEBEL_CLIENT_ROOT directory, which are described in “Verifying the Siebel Client 
Directory Structure” on page 43. Additional subdirectories, other than those shown 
here, may apply for your client installations.

NOTE: When you create a package, you can decide which modules or files to include 
or exclude in the package for distribution to end users. Do not remove any modules 
or component subdirectories or files unless you know they will not be needed. 
Verify that your Siebel directory structure contains the files you require, including 
any modified files or other configuration changes.

Table 12. Siebel eBusiness Applications Modules for Packaging

Component Description

ACTUATE Actuate-related files for Reports, located in the 
SIEBEL_CLIENT_ROOT\actuate directory.

BIN Siebel executable files (binaries) located in the 
SIEBEL_CLIENT_ROOT\bin directory, including the required DLL files, 
configuration files, and executable files such as siebel.exe.

If you have customized the configuration files, replace the default 
configuration files in this directory with your own before you start the 
Packager utility.

Note: When you create a package, include this module and all 
components in the bin directory, except for the user preferences file, 
user_ID&SiebelAppname.spf, and the session file, siebel.ses. 

CHARTS Charts server components for generating charts, located in the 
SIEBEL_CLIENT_ROOT\charts directory.

FONTS Barcode font files, located in the SIEBEL_CLIENT_ROOT\fonts directory.

ISSTEMPL Template files for the SIS (Siebel Interactive Selling) CDA application, 
located in the SIEBEL_CLIENT_ROOT\isstempl directory.
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LOCAL Location of the local database, local Siebel File System, and docking files 
for Siebel Remote, located in the SIEBEL_CLIENT_ROOT\local directory. 

Note: Include this module in order to create the local directory when you 
create a package for a full installation. However, you should not initialize 
a local database before you create the package. Each local database is 
unique to an individual user and should not be packaged.

LOCALE Language-specific files, located in the SIEBEL_CLIENT_ROOT\locale 
directory.

Note: Include this module and all components in the locale directory 
when you create a package for a full installation.

LOG Log files from Siebel client operations (such as synchronization), located 
in the SIEBEL_CLIENT_ROOT\log directory.

Note: Include this module in order to create the log directory when you 
create a package for a full installation.

MSGTEMPL Message template files used by the Siebel client, located in the 
SIEBEL_CLIENT_ROOT\msgtempl directory.

Note: Include this module and all components in the msgtempl directory 
when you create a package for a full installation.

OBJECTS Object configuration template files (configured objects), located in the 
SIEBEL_CLIENT_ROOT\objects directory—the precompiled SRF file to 
distribute to end users.

The objects directory must contain at least one SRF file before you start 
the Packager utility.

Note: Include this module and all components in the objects directory 
when you create a package for a full installation.

PACKAGER Note: It is recommended that you do not include the Packager utility 
itself when you create a package for distribution to end users.

PATCH_BACK Removes modules that were applied as part of a patch.

Note: It is recommended that you do not include this module when you 
create a package for distribution to end users.

Table 12. Siebel eBusiness Applications Modules for Packaging

Component Description
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PUBLIC HTML, help, JavaScript, image, and other files for the Siebel client, 
located in the SIEBEL_CLIENT_ROOT\public directory.

Note: Include this module and all components in the public directory 
when you create a package for a full installation.

REPORTS Report template files located in the SIEBEL_CLIENT_ROOT\reports 
directory. 

If you have created your own reports, replace the standard report 
templates in this directory with your own, or add your own, before you 
start the Packager utility.

Note: Include this module and all components in the reports directory 
when you create a package for a full installation.

SAMPLE Location of the Sample Database and sample Siebel File System, located 
in the SIEBEL_CLIENT_ROOT\sample directory—if you have installed 
the Sample Database.

Note: Generally, you would not distribute the Sample Database to your 
end users, who will access a local database (Mobile Web Client) or a 
server database (Dedicated Web Client).

You may instead decide to distribute a separate client installer package 
that includes the Sample Database. If you do this, include the Sample 
Database, sample configuration files that refer to the Sample Database 
(located in SIEBEL_CLIENT_ROOT\bin\LANGUAGE), and sample SRF 
files (located in SIEBEL_CLIENT_ROOT\objects).

SQLTEMPL SQL template files, located in the SIEBEL_CLIENT_ROOT\sqltempl 
directory.

TEMP Working report files, located in the SIEBEL_CLIENT_ROOT\temp 
directory.

Note: Include this module in order to create the temp directory when you 
create a package for a full installation.

Table 12. Siebel eBusiness Applications Modules for Packaging

Component Description
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Running the Siebel Packager Utility
This section describes how to run the Siebel Packager utility. The Packager utility 
wizard guides you in creating the custom Siebel client installer.

NOTE: You must run the Packager once for the base Siebel client modules (BASE 
option), and once for each language pack you want to include. To include elements 
in the same package, you must specify the same package name each time.

To run the Siebel Packager utility

1 From the Windows Start menu, select Programs >Siebel Client 7.x.x > 
Packager. 

The Siebel Client Packager wizard launches and the Choose Setup Language 
window appears.

2 Choose the language in which to conduct the rest of the Packager procedure and 
click OK. The Directory Definition window appears.

3 Specify the following values:

UPGRADE Siebel Anywhere upgrade files retrieved by the user, located in the 
SIEBEL_CLIENT_ROOT\upgrade directory. 

Note: This module is applicable only to upgrades, not to new 
installations.

WEBTEMPL Siebel Web templates, located in the SIEBEL_CLIENT_ROOT\webtempl 
directory. 

Note: Include this module and all components in the webtempl directory 
when you create a package for a full installation.

Table 12. Siebel eBusiness Applications Modules for Packaging

Component Description
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■ Package. The name of the package. This is used as the name of the self-
extracting archive file (if you create one) and as the name of the subdirectory 
under SIEBEL_CLIENT_ROOT\packager\temp in which the custom installer 
is created.

■ Siebel Client. The root-level directory of the Siebel client installation that is 
included in the custom installation. Accept the default, represented in this 
book as SIEBEL_CLIENT_ROOT.

■ Language Packs. Specify BASE or specify an installed language pack (for 
example, ENU for U.S. English). If you want to include language packs in the 
customized installer, select a language pack.

4 At the bottom-right of the window, choose Full Install or Patch Install, based on 
your desired goal:

■ Full Install. Intended for full installations or upgrades of Siebel eBusiness 
Applications. This performs an entire installation, using the parameters in 
the siebel.ini file.

■ Patch Install. Copies only the packaged files, preserving the same directory 
structure as the source. Typically, this is used with an existing installation not 
requiring further customizing. When you run a patch installer, it prompts 
only for the existing installation directory.

5 Click Next and the Module Definition window appears.

6 In the Module Definition window:

a Choose the Siebel modules to be included in the custom installation package.

A list of possible modules appears in the Modules list on the left. For 
explanations of some of these modules, see Table 12 on page 98.
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b If you want to include or exclude a template, select an item in the Modules 
list. Notice that *.* appears in the Include Templates box on the right.

The Include Templates and Exclude Templates boxes allow you to set the 
filters used to include or exclude files for each selected component. The 
default Include filter is *.*, which includes all files.

Include Templates also has an Include Subdirectories check box to indicate 
whether files in subdirectories for these components are included. 

NOTE: You do not need to modify Include Templates and Exclude Templates 
for a typical installer.

❏ If you want to prevent a directory from being created for a particular 
module, select the module and click Remove. 

❏ If you want to add modules that are located in the SIEBEL_CLIENT_ROOT 
directory but do not appear in the Modules list, click Add and specify the 
path of the module.

To create a required directory without any files, select that module from the 
Modules list and, under Include Templates, click Remove. 

NOTE: When preparing a full installation, do not remove any module or 
components unless you know they will not be needed. See module 
descriptions in Table 12 on page 98.

c Click Next and the Packaging screen appears.

7 To create the custom installer, click Start. 

The Packager utility displays progress information while the Packager executes 
and creates the package.

8 (Optional.) After this process is finished, you can further customize the behavior 
of the packaged installer by editing the siebel.ini file. To do so, click the button 
labeled Edit siebel.ini. See “Customizing Siebel.ini Files” on page 105.
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9 (Optional.) If you want to package the custom installer into a self-extracting 
archive, click Next.

NOTE: If you do not want to perform this step at this time, you can do it later by 
running the selfex.bat file in the directory 
SIEBEL_CLIENT_ROOT\Packager\Temp\package_name.

10 (Optional.) In the Self-extracting Archive window, if you are producing an 
installer for BASE, click Start to package the self-extracting archive.

The Packager creates the archive—a single executable (.exe) file in the directory 
SIEBEL_CLIENT_ROOT\Packager\Temp\package_name\selfex, and also 
specifies the name of the package in a message box. This step may take some 
time to complete, depending on the processing speed of the computer you are 
using. Verify the location of the executable file after the process has completed.

Making Your Customized Installer Available to End Users
After you have tested your customizations and are satisfied with the client installer 
you have created, make your customized installer available to end users. You can 
distribute your customized installer to end users using one of the methods 
described in this section. The suitability of each method will depend on many 
factors, including available network bandwidth.

Siebel Anywhere
You can distribute and execute the customized Siebel client installer automatically 
as a Siebel Anywhere kit.

User access to a Siebel Anywhere kit requires an existing installation of the Siebel 
client on the user’s machine. Therefore, you can use Siebel Anywhere for upgrades, 
but not for an initial deployment or new installations.

For more information on using Siebel Anywhere, see Siebel Anywhere 
Administration Guide.
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CD-ROM, Local Area Network, or Other Method
For new installations or for upgrades, you can distribute the customized Siebel 
client installer to end users on CD-ROM or local area network (LAN). You can also 
distribute the customized Siebel client installer across a WAN or VPN, using a 
modem, by email, or by FTP.

The customized Siebel client installer may optionally be in the form of a self-
extracting archive file. Packaging the installer as a self-extracting archive is 
generally best for distribution methods such as using a modem, email, or FTP.

To distribute a customized Siebel client installer on CD-ROM or network

1 CD-ROM: Place the self-extracting archive file (package_name.exe) or installer 
package directory onto a CD-ROM, then distribute the CD-ROM to your users.

2 Network: Place the self-extracting archive file (package_name.exe) or installer 
package directory in a network-accessible directory, such as on a LAN. Make 
sure that all users have access to this directory.

3 Notify your users how to access the installer package and initiate the installation 
process. Optionally, users may need to copy files to their local machine, such as 
if you packaged a self-extracting archive file.

The procedure users will follow varies according to how you distributed the 
package, how you created the package, and whether the package is a self-
extracting archive file. Users can install a self-extracting archive package by 
running the archive file.

Customizing Siebel.ini Files
The siebel.ini file controls the behavior of the Siebel client installation. Separate 
versions of this file are created for packages for a base installation and those for 
language packs. The siebel.ini file is located in the following directories, where 
package_name is the name of your package:

■ SIEBEL_CLIENT_ROOT\packager\temp\package_name (for BASE)
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■ SIEBEL_CLIENT_ROOT\packager\temp\package_name\LANGUAGE (where 
LANGUAGE is the subdirectory for the applicable language pack, such as ENU 
for U.S. English)

NOTE: The value of the FolderName parameter, described in “Key Parameters in 
Siebel.ini File” on page 106, must be the same in all siebel.ini files for the same 
package.

Review all applicable siebel.ini files and customize the files as necessary to make 
sure the client installation uses the correct settings for your specific environment.

NOTE: If you customize the siebel.ini file, do so at Step 8 on page 103 in “Running 
the Siebel Packager Utility” on page 101. This step occurs after you create the 
package itself, and before you (optionally) create a self-extracting archive file. If you 
customize the siebel.ini file before you create the package, those changes will not 
become part of the customized installer.

The siebel.ini file determines all of the parameters used by the client installer, 
including the following:

■ Third-party software programs and versions that are required on the client 
computer

■ System settings that improve performance

■ Configuration of data sources

■ Which installation screens end users see when they run the Siebel client installer

■ Which shortcuts (icons) are created upon installation

Instructions for modifying the siebel.ini file can be found in the file itself. Use a 
standard text editor to review and edit siebel.ini.

Key Parameters in Siebel.ini File
The following parameters, located in different sections in the siebel.ini file, are 
generally already set appropriately, based on performing the master installation. 
Review these settings and modify those that require it.
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■ Set the FolderName parameter in the [Defaults] section for each language pack 
to the same value as the FolderName parameter in the [Defaults] section for the 
base installation. If you do so, the relevant shortcuts (icons) will be delivered to 
the same location under the Windows Start menu.

■ Set the RootDirectory parameter in the [Defaults] section to the installation 
location on the target system—for a full, language pack, or patch (maintenance 
release) installation. By default, the parameter value is populated by the 
Packager utility to correspond to the staging location where you built the 
package—for example, C:\sea752\client. You can leave this value as is, or set it 
to another location on the target system. 

■ For Siebel Dedicated Web Client, set the ServerDatabase parameter in 
[ServerDatabase] to the appropriate database server for connected use, such as: 
DB2UDB, SQL Server, or Oracle80.

■ Do not enclose the DockConnString parameter value in double quotes.

■ If the SystemDSN parameter is set to no, the installer creates single-user data 
sources. This type of data source is visible only to the user who installed it.

If SystemDSN is set to yes, the installer creates system data sources, which are 
shared by all users who log into that particular machine. You must have 
administrator privileges to create a system installation.
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■ You can use the addLanguages parameter to enable users to add language packs 
to an existing Siebel client installation.

If addLanguages (in the [Dialog] section) is defined and set to yes, when the 
user installs, a single dialog box appears, listing all installed instances of the 
Siebel client. (This dialog box corresponds to the one described in Step 4 on 
page 33 in “Installing the Siebel Mobile and Dedicated Web Client” on page 32.) 
The user can choose a Siebel client instance to add a language pack to, or click 
Next to install a new Siebel client.

If addLanguages is set to no, then an installation directory must be specified 
using the RootDirectory parameter.

For a package installing a patch, do not use the addLanguages parameter.

NOTE: Do not enable any dialog boxes in a packaged installation, except the one 
described above for adding languages. Enabling any other dialog boxes in the 
Packager is redundant, because the necessary user input has already been captured 
by the initial installation. (If other dialog boxes are enabled, user input is ignored.)

Major Sections of the Siebel.ini File
The major sections of the siebel.ini file are as follows:

[Startup]—This section defines values needed for setup initialization. Examples 
include version number, patch install, application name, and so forth.

[AppCollision]—This section defines the file which defines a product. This file is 
then used to validate that no installations try to overwrite one another.

[StartupFiles]—This section defines third-party startup (.ini) files that may need to 
be updated or expanded during installation.

[DeleteFiles]—Defines any files that need to be deleted prior to file delivery.

[Module]—Defines component descriptions for use in the user interface.

[Module.Configuration]—This section defines what components or features to 
assign to a given setup type.
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[Module.Destination]—This section defines where a component or feature should 
be installed on the end user’s system.

[Regsvr32]—This section defines the files to register on Windows when using the 
regsvr32 utility.

[Prerequisites]—This section defines prerequisites for installation to proceed.

[Dialog]—This section defines what dialog boxes should be enabled or disabled in 
the installer at run time.

[Defaults]—This section defines default values to be used in the user interface of 
the installer, or the prompt to use if a dialog box is turned off.

[Behavior]—This section defines general installer behavior, such as whether to 
abort or continue on a failed condition.

[RunAfter]—This section defines the programs or functions to run or call after the 
installation is complete.

[CustomUninstall]—This section defines programs or what functions should be run 
or called during uninstallation.

[Icons]—This section defines what shortcuts (icons) to create on the end user’s 
system.

Siebel.ini File Hierarchy and Organization
This section describes the hierarchy and organization of the siebel.ini file.

Sections Containing Child Sections
In sections like the following, a child subsection provides additional information 
about the parent section. Parent and child sections take the following format:

[Parent_Section_Name]
Child_Section_Name = Value

where Child_Section_Name is a key in the parent section.

[Child_Section_Name]
Key = Value
Key = Value
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The key in the parent section tells the installer whether that element is enabled. If 
it is enabled, the installer looks to the child section whose name is the key from the 
parent. 

In the following example, the [AppCollision] section is traversed. The installer finds 
a key (GtwySrvr) and determines if that check should be enabled. In this case, the 
check would be enabled if a Siebel Gateway was selected during installation. If so, 
the installer looks for the definition. The previous key (GtwySrvr) is redefined as a 
section, which then defines the behavior.

[AppCollision]
GtwySrvr         = $(Gateway Selected)=yes

[GtwySrvr]
Description      = Siebel Gateway
File             = gtwysrvr\bin\namesrvr.exe

Sections Without Child Sections
In sections like the following, all necessary information for the key is contained in 
the value:

[Section_Name]
Key = Value

In the following example, the installer displays a welcome dialog box. All necessary 
information for the key is contained in the value; no child section is required.

[Dialog]
Welcome = yes

Testing an Installer After Customizing the Siebel.ini File
After you customize the siebel.ini file, you should test the installer.

To test an installer

1 Finish modifying the siebel.ini file.

2 Run install.exe from the SIEBEL_CLIENT_ROOT\packager\temp\package_name 
directory on the network installation server.

3 Repeat Step 1 and Step 2 until the siebel.ini file is configured to achieve the 
desired installation.
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4 Test any self-extracting archive file you create.

NOTE: If you test a self-extracting archive file on the same machine on which you 
generated the package, the installer will overwrite the Siebel client directory. To 
install to a different location, specify an installation directory using the 
RootDirectory parameter in the siebel.ini file. Or, run the archive file on a 
different machine.
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Siebel eBusiness Applications use configuration files to hold information that tells 
the Siebel clients how to function at startup. Examples of configuration files are 
siebel.cfg, used by Siebel Sales, and uagent.cfg, used by Siebel Call Center. Use the 
information presented in this appendix to help determine which parameters you 
must set to achieve optimal performance and to enable the features you require. 

The parameters described in this appendix apply to deployments of the Siebel 
Mobile or Dedicated Web Client. Some parameters also apply to Siebel Servers.

Many parameters are primarily described in other books on Siebel Bookshelf.

NOTE: Not all of the configuration parameters used by Siebel applications are 
mentioned in this book. Some parameters are not documented on Siebel Bookshelf.

This appendix includes these sections:

■ “Editing Configuration Files” on page 116 provides information to help you edit 
configuration files.

■ “Configuration Parameters Index” on page 117 provides an alphabetical list of 
selected configuration parameters and provides references to where they are 
documented. 

■ “Siebel Application Parameters for Client” on page 128 describes some of the 
parameters in the [Siebel] section of the configuration file.

■ “Data Source Parameters” on page 134 describes some of the parameters in data 
source sections of the configuration file.

■ “Sample Selection from Configuration File” on page 144 provides an example of 
sections from the file uagent.cfg.
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Initial values for parameters in the configuration files are either predefined by Siebel 
Systems or defined using values you specify during installation or at other times.

Some parameter values may be represented using the notation $(param_name). 
These parameter values are substituted automatically, such as during client 
installation. For example, the value of the ConnectString parameter for a data 
source that has not yet been configured appears as follows:

ConnectString = $(ConnectString)

Configuration files may also be updated when you initialize the local database for 
a Siebel Mobile Web Client, or when you run the LDAP/ADSI configuration utility. 
For more information about initializing the local database, see Siebel Remote and 
Replication Manager Administration Guide. For more information about the LDAP/
ADSI configuration utility, see Security Guide for Siebel eBusiness Applications.

Siebel Client and Server Parameters
The parameters described in this appendix apply to deployments of the Siebel 
Mobile or Dedicated Web Client.

Some parameters, such as those in the [SWE] section of the configuration file, are 
also read by the Application Object Manager on the Siebel Server, and therefore 
apply also to deployments of the Siebel Web Client.

Each section of the configuration file identifies whether the parameters it contains 
apply only to Siebel client installations (for Siebel Mobile or Dedicated Web Client) 
or if they apply also to Siebel Server (for Siebel Web Client deployments).

NOTE: For configuration file parameters that apply only to Siebel Mobile and 
Dedicated Web Client, equivalent parameters are usually defined in the Server 
Manager as Siebel Server component parameters for the Application Object 
Manager. In a mixed-client deployment, you must make sure to set and maintain 
configuration file parameters and component parameters consistently, where 
appropriate. For more information about server component parameters, see Siebel 
Server Administration Guide.
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Siebel Application Configuration Files
Table 13 lists several configuration files and their associated Siebel applications. 
Your installation may contain additional configuration files besides those listed.

The configuration files are located in the SIEBEL_CLIENT_ROOT\bin\LANGUAGE 
directory on the Siebel Mobile or Dedicated Web Client, or in the 
SIEBSRVR_ROOT\bin\LANGUAGE directory on the Siebel Server. The name of the 
configuration file varies, depending on the application you are using. Separate 
configuration files are provided for each supported language.

The eapps.cfg File
Another important configuration file is eapps.cfg. This file is located in 
SWEAPPS_ROOT\SWEApp\bin directory, where SWEAPPS_ROOT is the directory in 
which you installed the Siebel Web Server Extension (on the Web server).

These parameters apply in an environment supporting the Siebel Web Client. The 
file may need to be modified in scenarios such as configuring Web Single Sign-on 
(Web SSO), or adding new application virtual directories. Some of the key 
parameters in the eapps.cfg file are:

■ AnonPassword

■ AnonUserName

■ AnonUserPool

■ AutomaticSession

Table 13. Some Siebel Applications and Associated Configuration Files

Siebel Application Configuration File

Siebel Call Center uagent.cfg

Siebel Employee Relationship Management erm.cfg

Siebel Marketing market.cfg

Siebel Partner Manager pmanager.cfg

Siebel Sales siebel.cfg

Siebel Service sfs.cfg
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■ CookieSession

■ EncryptSessionId

■ StatsPage

■ URLSession

For more information about the eapps.cfg file and its parameters, see Siebel Server 
Administration Guide. See also the Siebel Server Installation Guide for the operating 
system you are using and Security Guide for Siebel eBusiness Applications.

Editing Configuration Files
The Siebel application configuration files are plain-text files, and can be edited 
manually using a text editor. You can add parameters and their values or change 
values for existing parameters. 

When you edit configuration files, use a text editor that does not add non-text 
characters to the file. For example, use Microsoft Notepad instead of Microsoft Word 
or WordPad.

There are many reasons why you might edit configuration files. For example, you 
may want to do so at some point after the installation in order to enable or disable 
certain functionality and features. As appropriate, you must make changes in all 
configuration files for the applications you are using. For each new application you 
create, you must copy and edit a configuration file to suit your needs.

NOTE: A configuration parameter that is not needed can be commented out by 
inserting a semicolon at the start of the line.

To edit a Siebel configuration file

1 Create a backup copy of the default configuration file for which you want to edit 
parameter values, and save that file as a backup file.

2 Using any text editor, such as Notepad, open the default version of the 
configuration file.

3 Edit parameter values, as necessary, to obtain the desired application behavior.
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4 Run a test using the configuration file that you edited.

5 If there is an error in your test, correct the error and try again, or restore the 
configuration file from the backup file.

6 If no error occurs, then use the modified configuration file.

Configuration Parameters Index
Table 14 contains an alphabetical listing of some of the configuration parameters 
from Siebel application configuration files such as siebel.cfg or uagent.cfg. This list 
shows the name of the section in which each parameter can be found and identifies 
where the parameter is documented. This list is not comprehensive.

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented

AccessDir [Siebel] “AccessDir” on page 128

AccessibleEnhanced [SWE] Siebel eBusiness Applications 
Accessibility Guide

ADSI [SecurityAdapters] Security Guide for Siebel eBusiness 
Applications

AllowAnonUsers [SWE] Security Guide for Siebel eBusiness 
Applications

ApplicationName [Siebel] “ApplicationName” on page 128

ApplicationPassword Applicable security 
adapter sections, such as:

[ADSI]
[LDAP]

Security Guide for Siebel eBusiness 
Applications

ApplicationSplashText [Siebel] “ApplicationSplashText” on page 128

ApplicationStyle [SWE] Siebel eBusiness Applications 
Accessibility Guide

ApplicationTitle [Siebel] “ApplicationTitle” on page 128
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ApplicationUser Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

AutoStopDB Applicable data source 
sections, including:

[Local]
[Sample]

“AutoStopDB” on page 135

BaseDN Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

CaptionPrefix [Siebel] “CaptionPrefix” on page 129

CaseInsensitive Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]
[GatewayDataSrc]

“CaseInsensitive” on page 135

ClientRootDir [Siebel] “ClientRootDir” on page 129

CommConfigCache [Communication] Siebel Communications Server 
Administration Guide

CommConfigManager [Communication] Siebel Communications Server 
Administration Guide

CommConfigManagerName [Communication] Siebel Communications Server 
Administration Guide

CommEnable [Communication] Siebel Communications Server 
Administration Guide

CommLocalDriver [Communication] Siebel Communications Server 
Administration Guide

CommLogDebug [Communication] Siebel Communications Server 
Administration Guide

CommLogFile [Communication] Siebel Communications Server 
Administration Guide

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
118 Siebel Web Client Administration Guide Version 7.5.3



Configuration Parameters

Configuration Parameters Index
CommMaxLogKB [Communication] Siebel Communications Server 
Administration Guide

CommMaxMsgQ [Communication] Siebel Communications Server 
Administration Guide

CommReleaseLogHandle [Communication] Siebel Communications Server 
Administration Guide

CommReqTimeout [Communication] Siebel Communications Server 
Administration Guide

CommSimulate [Communication] Siebel Communications Server 
Administration Guide

ComponentName [Siebel] “ComponentName” on page 129

ConnectString Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]
[GatewayDataSrc]

[ActuateReports]

“ConnectString” on page 136 (data 
sources)

Siebel Reports Administration Guide 
(ActuateReports)

ContactLogin Applicable data source 
sections

“ContactLogin” on page 136

CORBADLL [Siebel] “CORBADLL” on page 129

CredentialsAttributeType Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

DataSource [Siebel] “DataSource” on page 129

DebugLevel [EMail] Siebel Communications Server 
Administration Guide

DefaultChartFont [Siebel] “DefaultChartFont” on page 129

DefaultMailClient [EMail] Siebel Communications Server 
Administration Guide

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
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DLL Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]
[GatewayDataSrc]

“DLL” on page 136

DllName Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

DockConnString Applicable data source 
sections, including:

[Local]

“DockConnString” on page 136

DockRecvTxnsPerCommit Applicable data source 
sections

“DockRecvTxnsPerCommit” on 
page 136

DockRepositoryName [Siebel] “DockRepositoryName” on page 129

DockTxnsPerCommit Applicable data source 
sections, including:

[Local]

“DockTxnsPerCommit” on page 137

EditFieldCaption [SWE] Siebel Tools Reference

EditFieldType [SWE] Siebel Tools Reference

Enable [DataCleansing]
[DeDuplication]

Siebel Data Quality Administration 
Guide

EnableCDA [SWE] Siebel Server Installation Guide for 
UNIX

Siebel Interactive Selling Applications 
Upgrade Guide

EnableCORBA [Siebel] “EnableCORBA” on page 130

EnableEmailClientAutomation [SWE] Siebel Communications Server 
Administration Guide

EnableFQDN [Siebel] Siebel Reports Administration Guide

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
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EnableOLEAutomation [Siebel] “EnableOLEAutomation” on 
page 130

EnablePersonalization [Siebel] “EnablePersonalization” on page 130

EnableReportServer [ActuateReports] Siebel Reports Administration Guide

EnableScripting [Siebel] “EnableScripting” on page 130

EnableWebClientAutomation [SWE] “High Interactivity Deployment—
ActiveX Requirements” on page 59

Siebel Communications Server 
Administration Guide

Siebel Object Interfaces Reference

Upgrade Guide

EncryptApplicationPassword Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

EncryptCredentialsPassword Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

EncryptPassword [Siebel] “EncryptPassword” on page 131

EnterpriseServer Applicable data source 
sections, including:

[Local]
[ServerDataSrc]

“EnterpriseServer” on page 137

eProdCfgAutoMatchInstance [InfraObjMgr] Product Administration Guide

eProdCfgMaxNumbOfWorkerReuses [InfraObjMgr] Product Administration Guide

eProdCfgNumbOfCachedCatalogs [InfraObjMgr] Product Administration Guide

eProdCfgNumbOfCachedFactories [InfraObjMgr] Product Administration Guide

eProdCfgNumOfCachedObjects [InfraObjMgr] Product Administration Guide

eProdCfgNumbofCachedWorkers [InfraObjMgr] Product Administration Guide

eProdCfgSnapshotFlg [InfraObjMgr] Product Administration Guide

ExtendedKeyboard [SWE] Applications Administration Guide

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
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ExtensionType Applicable data source 
sections

“ExtensionType” on page 137

FileSystem Applicable data source 
sections, including:

[Sample]
[ServerDataSrc]

“FileSystem” on page 138

FQDN [Siebel] Siebel Reports Administration Guide

GatewayAddress Applicable data source 
sections, including:

[ServerDataSrc]

“GatewayAddress” on page 138

GatewayDataSrc [DataSources] “GatewayDataSrc” on page 134

Hidden Applicable data source 
sections, including:

[GatewayDataSrc]

“Hidden” on page 139

HighInteractivity [SWE] Siebel Tools Reference

InsensitivityFactor Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]
[GatewayDataSrc]

“InsensitivityFactor” on page 139

InsUpdAllCols Applicable data source 
sections

“InsUpdAllCols” on page 139

IntegratedSecurity Applicable data source 
sections

“IntegratedSecurity” on page 140

JseCorbaConnector [Siebel] “JseCorbaConnector” on page 131

LDAP [SecurityAdapters] Security Guide for Siebel eBusiness 
Applications

ListRowStyle [SWE] Siebel Tools Reference

Local [DataSources] “Local” on page 134

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
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LocalDbODBCDataSource [Siebel] “LocalDbODBCDataSource” on 
page 132

LoginView [SWE] Security Guide for Siebel eBusiness 
Applications

LotusForm [EMail] Siebel Communications Server 
Administration Guide

MarkupLanguage [SWE] Siebel Wireless Administration Guide

MaxCachedCursors Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]

“MaxCachedCursors” on page 140

MaxCachedDataSets Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]

“MaxCachedDataSets” on page 140

MaxConnections Applicable data source 
sections

“MaxConnections” on page 140

MaxCursorSize Applicable data source 
sections, including:

[ServerDataSrc]

“MaxCursorSize” on page 140

MessageBarUpdateInterval [Siebel] Applications Administration Guide

MultiCurrency [Siebel] “MultiCurrency” on page 132

NonSQL Applicable data source 
sections

“NonSQL” on page 140

NumberOfListRows [SWE] Object Types Reference

Personalization Administration Guide

Siebel Wireless Administration Guide

Siebel Mobile Connector Guide

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
Version 7.5.3 Siebel Web Client Administration Guide 123



Configuration Parameters

Configuration Parameters Index
OLEAutomationDLL [Siebel] “OLEAutomationDLL” on page 132

OLEMessagePendingDelay [Siebel] “OLEMessagePendingDelay” on 
page 132

OutlookForm [EMail] Siebel Communications Server 
Administration Guide

PasswordAttributeType Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

PersonalizationLog [Siebel] “PersonalizationLog” on page 132

Port Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

PrefetchSize Applicable data source 
sections, including:

[ServerDataSrc]

“PrefetchSize” on page 141

PrimaryEnterprise Applicable data source 
sections, including:

[GatewayDataSrc]

“PrimaryEnterprise” on page 141

ProtocolName [ActuateReports] Siebel Reports Administration Guide

RemoteSearchServer [Siebel] “RemoteSearchServer” on page 132

RemoteSearchServerPath [Siebel] “RemoteSearchServerPath” on 
page 132

ReportCastDomain [ActuateReports] Siebel Reports Administration Guide

ReportCastHost [ActuateReports] Siebel Reports Administration Guide

ReportsDir [Siebel] “ReportsDir” on page 132

ReportServerName [ActuateReports] Siebel Reports Administration Guide

ReportsODBCDataSource [Siebel] “ReportsODBCDataSource” on 
page 132

RepositoryFile [Siebel] “RepositoryFile” on page 132

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
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RequestServer Applicable data source 
sections, including:

[ServerDataSrc]

“RequestServer” on page 141

RequiredIndicator [SWE] Siebel Developer’s Reference

ReverseFillThreshold Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]

“ReverseFillThreshold” on page 141

RolesAttributeType Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

RoxDir [ActuateReports] Siebel Reports Administration Guide

Sample [DataSources] “Sample” on page 134

SAPRfcConnectString [SAPSubsys] Siebel Connector for SAP R/3

SAPRfcDestEntry [SAPSubsys] Siebel Connector for SAP R/3

SAPRfcPassword [SAPSubsys] Siebel Connector for SAP R/3

SAPRfcUserName [SAPSubsys] Siebel Connector for SAP R/3

ScriptingDLL [Siebel] “ScriptingDLL” on page 133

SearchDefName [Siebel] “SearchDefName” on page 133

SearchEngine [Siebel] “SearchEngine” on page 133

SearchInstallDir [Siebel] “SearchInstallDir” on page 133

SecureBrowse [SWE] Security Guide for Siebel eBusiness 
Applications

SecureLogin [SWE] Security Guide for Siebel eBusiness 
Applications

SecurityAdapter [Siebel] “SecurityAdapter” on page 133

ServerDataSrc [DataSources] “ServerDataSrc” on page 134

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
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ServerName Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

SharedCredentialsDN Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

SharedModeUsersDir [Siebel] “SharedModeUsersDir” on page 133

ShowMessageBar [Siebel] Applications Administration Guide

ShowWriteRecord [SWE] Siebel Partner Relationship 
Management Administration Guide

SiebelExtMailClientAttDir [EMail] Siebel Communications Server 
Administration Guide

SiebelUsernameAttributeType Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

SingleSignOn Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

SortCollation Applicable data source 
sections, including:

[Local]
[Sample]

“SortCollation” on page 141

SqlStyle Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]

“SqlStyle” on page 143

SslDatabase Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

SystemSWFName [SWE] Siebel Tools Reference

SystemSWSName [SWE] Siebel Tools Reference

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
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TableOwner Applicable data source 
sections, including:

[Local]
[Sample]
[ServerDataSrc]

“TableOwner” on page 144

TempDir [Siebel] “TempDir” on page 133

TreeNodeX (several parameters that 
are similarly named—for example, 
TreeNodeCollapseCaption)

[SWE] Siebel Tools Reference

TrustToken Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

Type [DataCleansing]
[DeDuplication]

Siebel Data Quality Administration 
Guide

UpperCaseLogin Applicable data source 
sections

“UpperCaseLogin” on page 144

UseAdapterUsername Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

UseRemoteConfig Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

UsernameAttributeType Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

UserSWFName [SWE] Siebel Tools Reference

UserSWSName [SWE] Siebel Tools Reference

UseSsl Applicable security 
adapter sections

Security Guide for Siebel eBusiness 
Applications

Version [Siebel] “Version” on page 133

ViewPreloadSize [SWE] Siebel Tools Reference

View1 [Preload] “Siebel Mobile Web Client and Siebel 
QuickStart” on page 91

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented
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Siebel Application Parameters for Client
Table 15 defines Siebel application parameters that appear in the section [Siebel].

These parameters apply only to Siebel Mobile and Dedicated Web Client. For the 
Siebel Web Client, the parameters are defined as server parameters on the 
Application Object Manager.

View2 [Preload] “Siebel Mobile Web Client and Siebel 
QuickStart” on page 91

Viewn [Preload] “Siebel Mobile Web Client and Siebel 
QuickStart” on page 91

WebTemplatesVersion [SWE] Siebel Tools Reference

Table 14. Index of Configuration Parameters

Configuration Parameter Name Section Name Where Documented

Table 15. Siebel Client Application Parameters

Name Description

AccessDir Specifies the directory where Microsoft Access is installed.

ApplicationName Name of the application object in the repository to use, such as Siebel 
Sales or Siebel Service. ApplicationName determines which splash 
screen appears and which set of menus is enabled. 

ApplicationSplashText Text that appears on a splash screen when starting up a Siebel 
application. 

The default varies by the application. If you are starting Siebel Sales, for 
example, ApplicationSplashText is set to Siebel Sales by default. 

ApplicationTitle Changing the text in the ApplicationTitle parameter in the 
configuration file changes the Application Title value in the multivalue 
group applets and the Title that appears on the left-hand side of the 
application title bar.

As necessary, make this change in the appropriate configuration file for 
the intended application. For example, for Siebel Call Center, this 
parameter would be set, in the file uagent.cfg, to Siebel Call Center.
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CaptionPrefix Allows customizing of the title in the upper left-hand corner of the Siebel 
client application. Reads Siebel by default.

ClientRootDir Specifies the directory where the Siebel client software is installed.

For more information, see “Mobile Web Client Configuration 
Parameters” on page 79.

ComponentName Specifies the Siebel Anywhere configuration that should be used during 
version check. Navigate to the Siebel Anywhere Administration > 
Configurations view to see the configurations.

Change the setting for this parameter if you want this configuration file 
to be version-checked by a specific Siebel Anywhere configuration. 

For example, if you want to version-check the Siebel software used at 
one facility separately from the software used at another facility, create 
two Siebel Anywhere configurations appropriately named. Then, in the 
configuration file for each set of users, enter a different value for the 
ComponentName parameter.

It is recommended to use only alphanumeric characters plus dashes and 
normal parentheses for the ComponentName parameter. If you want to 
use the Priority upgrade feature, the maximum character length for the 
Upgrade Component name should be 40.

CORBADLL The Siebel extension layer for CORBA.

DataSource Name of the default data source that appears in the Connect to drop-
down list in the Siebel login screen. Must correspond to an existing data 
source defined in the configuration file. By default, this parameter is set 
to Local.

DefaultChartFont Font name specification for chart applets. Defaults to Arial-10 normal.

DockRepositoryName Allows the application to read repository information straight from the 
database, rather than from the Siebel repository file (SRF) file. The value 
should match the repository used for compiling the SRF file.

For more information, see “Mobile Web Client Configuration 
Parameters” on page 79.

Table 15. Siebel Client Application Parameters

Name Description
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EnableCORBA EnableCORBA is used to load CORBADLL. For all installations except 
CORBA Object Manager, this flag is FALSE by default.

When using a configuration file with one of the CORBA Object Manager 
executables, ssomorbx.exe or ssomvisi.exe, the CORBA Object Manager 
installer sets the EnableCORBA parameter to TRUE.

EnableOLEAutomation TRUE or FALSE. Enables OLE interfaces. 

This parameter must be set to TRUE (the default) in order for the Siebel 
Mobile or Dedicated Web Client to generate reports locally.

EnablePersonalization Must be set to TRUE to activate the personalization (content targeting) 
functionality.

Siebel workflow processes will not execute properly until 
personalization events are reloaded. For information on clearing and 
reloading personalization data, see Personalization Administration 
Guide.

EnableScripting TRUE or FALSE. Enables use of Siebel Visual Basic or Siebel eScript.

For more information, see “Configuring Client When Siebel VB or Siebel 
eScript Not Licensed” on page 42.

Table 15. Siebel Client Application Parameters

Name Description
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EncryptPassword Determines whether to encrypt the user’s password before passing it the 
RDBMS. It is used by customers who want to prevent their users from 
using SQL*Plus or some other RDBMS tool to directly log into the server 
database, rather than by using Siebel eBusiness Applications.

When TRUE, a simple encryption algorithm is applied to the password 
before it is sent to the database. This occurs when users attempt to log 
into Siebel eBusiness Applications with their password. The users’ 
Oracle login must also be set up with the encrypted version of the 
password. There is a special utility to help the administrator set these up.

Note: EncryptPassword applies to the Dedicated Web Client (that is, 
connecting to the server database); however, these users must use the 
same authentication method that is implemented for users of the Siebel 
Web Client. This parameter does not apply to the Mobile Web Client 
(connecting to the local database). Encrypted passwords for mobile 
users may be stored in the server database for when such users connect 
to the server database (unless another authentication mechanism is 
used).

For more information, see Security Guide for Siebel eBusiness 
Applications.

For information about authentication options for local database 
synchronization for mobile users, see Siebel Remote and Replication 
Manager Administration Guide.

JseCorbaConnector Required for CORBA support if you are using Siebel eScript and calling 
CORBA from eScript. This parameter defines the name of the eScript 
CORBA extension DLL.

Change this setting, depending on the CORBA ORBs (Object Request 
Broker) that you are using:

■ Use corbavgn.dll for Inprise Visibroker

■ Use corborbx.dll for Iona ORBIX

The default setting for this parameter is corbavgn.dll.

Note: The ScriptingDLL parameter must be set to sscfjs.dll to select 
Siebel eScript as the scripting language. By default, the ScriptingDLL 
parameter is set to Visual Basic.

Table 15. Siebel Client Application Parameters

Name Description
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LocalDbODBCDataSource Name of the ODBC data source that is set up to access the local database. 
It is used by a variety of features in the Siebel eBusiness Applications 
and in Siebel Tools. It should not need to be modified because it is 
correctly configured by the installation program.

MultiCurrency TRUE or FALSE. Enables multicurrency support.

OLEAutomationDLL Name of the DLL file that implements OLE interfaces.

OLEMessagePendingDelay Controls the amount of time that the Siebel application waits for an OLE 
server to respond to a request before a timeout message appears:

Server not responding ...

This parameter should be set in milliseconds, contained within 
quotation marks. For example, for 15 seconds, set 
OLEMessagePendingDelay to 15000.

The default setting is eight seconds (8000). You may want to increase the 
timeout on slow computers so that the timeout message does not appear 
as frequently.

PersonalizationLog Add the following to the configuration file to view a log of all 
personalization activity:

PersonalizationLog = "C:\personalization.txt"

where C: is the drive where you want to store the log. The log may assist 
in the process of debugging your rules, events, and actions.

RemoteSearchServer TRUE or FALSE. TRUE indicates that searches are performed on a remote 
machine; FALSE indicates that searches are performed on a local 
machine.

RemoteSearchServerPath Indicates the name of the remote machine that performs searches.

ReportsDir Directory where reports are installed. It is typically left blank.

ReportsODBCDataSource Name of ODBC data source used to connect to modules such as Crystal 
Reports.

RepositoryFile Name of the Siebel SRF file to use.

RepositoryFile is the physical file that contains all runtime object 
definitions.

Table 15. Siebel Client Application Parameters

Name Description
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ScriptingDLL Name of the shared library that implements Siebel Visual Basic or Siebel 
eScript. If the Siebel Server runs on a UNIX server machine, and you plan 
to use eScript, set the value of ScriptingDLL to sscfjs.so.

SearchDefName Search definition from Siebel Tools to be used for searching. 

SearchEngine Defines the search engine to be used for searching. Currently, only 
Hummingbird SearchServer is supported, for which this parameter 
should be set to Fulcrum.

SearchInstallDir File location of the Hummingbird SearchServer installation. Example:
C:\Program Files\Fulcrum.

SecurityAdapter Optional. May be set to LDAP, ADSI, or another appropriate value to 
specify the security adapter you are using.

If you do not set SecurityAdapter to anything, this indicates that you 
are using database authentication. The value to which you set 
SecurityAdapter must be a valid value specified in the 
[SecurityAdapters] section of the configuration file.

For more information about security adapter parameters, see Security 
Guide for Siebel eBusiness Applications.

SharedModeUsersDir Directory where user preference files are stored. It is typically left blank, 
otherwise it must be set to a directory under a network shared drive, but 
it cannot be set to the shared drive itself.

For example, if \\yourserver\common is the network shared drive, you 
cannot set SharedModeUsersDir to \\yourserver\common. Instead, 
set SharedModeUsersDir to a directory under \common.

For more information, see “User Preferences and Siebel Clients” on 
page 25.

TempDir Directory where temporary files should be created.

Version Represents version of file. This parameter is for internal use only and is 
automatically maintained by Siebel Anywhere. When you create an 
upgrade kit for the configuration file, Siebel Anywhere increments this 
version string appropriately, based on the version information from the 
Upgrade Components screen. 

Note: When you perform a Siebel Anywhere upgrade, you must 
manually upgrade files from the upgraded Siebel client directory to the 
Siebel Server directory.

Table 15. Siebel Client Application Parameters

Name Description
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This section describes parameters that pertain to the section [DataSources] and 
to individual data source sections that follow.

These parameters apply only to Siebel Mobile and Dedicated Web Client. For the 
Siebel Web Client, the parameters are defined as server parameters on the 
Application Object Manager.

Parameters for DataSources Section
Table 16 lists data sources in the Siebel configuration file, which appear in the 
section [DataSources]. Each data source also has its own section specifying 
parameters that apply to this data source.

NOTE: If you want to prevent a data source from being displayed as a choice in the 
Connect To: portion of the Siebel login screen, add two slash characters (//) in front 
of the data source in the [DataSources] section of the configuration file. For 
example: //Sample = Sample.

Table 16. Data Sources

Name Function

Local Defines parameters for connecting to the local database.

Sample Defines parameters for connecting to the Sample Database.

ServerDataSrc Defines parameters for connecting to the Siebel Database.

GatewayDataSrc Defines Siebel Gateway parameters.
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Parameters for Individual Data Source Sections
Table 17 lists parameters that specify properties associated with the different data 
sources listed under [DataSources]. Each data source section defines the 
properties of the particular data source. See “Sample Selection from Configuration 
File” on page 144 for parameters in individual data source sections such as [Local] 
or [ServerDataSrc].

Table 17. Data Source Parameters

Name Comment

AutoStopDB TRUE or FALSE. Applies to Sample or Local data sources only.

If TRUE, then the SQL Anywhere database engine exits when the user logs 
out. If FALSE (the default), then the database engine continues to run after 
the user logs out of the Siebel applications.

See also “QuickStart and AutoStopDB Configuration Parameter” on page 93 
and “Installing the Sample Database” on page 39. Regarding the local 
database, see also Siebel Remote and Replication Manager Administration 
Guide.

CaseInsensitive TRUE or FALSE. If TRUE, notifies the client to work with the database in 
case-insensitive mode.

See also the description of the InsensitivityFactor parameter for data 
sources.

Note: Queries against fields of type DTYPE_ID are always case-sensitive, even 
if the CaseInsensitive parameter is set to TRUE. For more information, 
see Applications Administration Guide.
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ConnectString Database-dependent string that defines how to connect to the database. 

For SQL Anywhere (for local database or Sample Database), the -q option 
hides the SQL Anywhere icon. The -c option indicates the initial cache size, 
and -ch indicates the limit of the cache size. The -m option indicates to the 
SQL Anywhere database engine to truncate the transaction log after each 
checkpoint.

The ConnectString parameter is also used to specify the Gateway Name 
Server machine in the GatewayDataSrc section. In the Dedicated Web 
Client’s configuration file, you must specify the Gateway Name Server’s 
hostname, preferably in a fully qualified form like node.domain.xxx. Failure 
to specify this parameter correctly results in the Server Administration 
screens not being accessible.

For more information on using connect strings for different server databases, 
see the Siebel Server Installation Guide for the operating system you are 
using.

ContactLogin TRUE or FALSE. If TRUE, indicates that the corresponding data source uses 
contact login, rather than employee login. Because a contact user is generally 
not associated one-to-one with a database account, you must use a security 
adapter to support contact users.

If FALSE, the data source is using employee login, rather than contact login.

DLL Name of the DLL file to use for the database connector code. The names 
differ depending upon whether you are using Oracle, SQL Server, DB2, and 
so on.

DockConnString Name of the docking server (Siebel Remote Server). It is the machine name 
of the Siebel Server against which the Mobile Web Client synchronizes.

For more information on setting this parameter for the local database, see 
“Mobile Web Client Configuration Parameters” on page 79.

DockRecvTxnsPerCommit Number of transactions received by the Mobile Web Client before a commit 
is issued to the database. The default value for this parameter is 10. Change 
the setting to:

■ A higher value if you have a fast network connection, such as a LAN. 
Increasing the value can provide better performance when synchronizing 
the Mobile Web Client with the server.

■ A lower value if you have a lower-bandwidth network connection, such 
as a modem.

Table 17. Data Source Parameters

Name Comment
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DockTxnsPerCommit Number of transactions processed before a commit is issued to the database.

For more information on setting this parameter for the local database, see 
“Mobile Web Client Configuration Parameters” on page 79.

EnterpriseServer Name of the Siebel Enterprise Server.

ExtensionType LINK or JOIN. This parameter indicates how data is retrieved from extension 
tables. It sets the default value for business components that do not have the 
Extension Type property defined. For more information on this parameter, 
see Siebel Tools Online Help.

Table 17. Data Source Parameters

Name Comment
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FileSystem Specifies how the Mobile or Dedicated Web Client accesses the Siebel File 
System. Generally, FileSystem and other parameters identified below are 
set during the Siebel client installation. 

Mobile Web Client. The following scenario for setting the FileSystem 
parameter applies to the Siebel Mobile Web Client. The Siebel File System 
should be installed locally on a Mobile Web Client, so that it is accessible 
when the client is not connected to the network and can be synchronized 
using Siebel Remote. See also “Siebel Mobile Web Client and Siebel Remote” 
on page 21.

■ Set the following parameter, where FS_location is a UNC location or a 
drive-letter path to the location on the client computer where the local 
Siebel File System was installed:

FileSystem = FS_location\att 

Dedicated Web Client. The following scenarios for setting the FileSystem 
parameter apply to the Siebel Dedicated Web Client. Make sure that users on 
the Dedicated Web Client have physical access privileges for the Siebel File 
System directories.

■ If the installation uses File System Manager (FSM), set the following 
parameters:

FileSystem = *FSM*
GatewayAddress = Siebel_Gateway_hostname 
EnterpriseServer = Siebel_Enterprise_Server_name 

■ If the installation does not use FSM, set the following parameter, where 
FS_location is a UNC location or a drive-letter path to the location on a 
network computer where the Siebel File System was installed:

FileSystem = FS_location\att 

Note: If your networked Siebel File System resides on a UNIX server, you will 
require a cross-platform NFS file system mounting tool in order to connect 
from Siebel Dedicated Web Clients running on Windows machines.

The system administrator must manually create the att subdirectory in the 
Siebel File System. If there is an existing File System installation, the 
administrator must move all file attachments from FS_location to 
FS_location\att.

GatewayAddress Virtual IP address of the Siebel Gateway.

Table 17. Data Source Parameters

Name Comment
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Hidden TRUE or FALSE. Determines if the data source shows up in the login screen’s 
picklist of data sources.

InsensitivityFactor Set to a positive integer value (default is 2). Applies only when the 
CaseInsensitive parameter is TRUE for the data source. The value controls 
the number of characters in each string that are treated as case-insensitive in 
a query. Not all database vendors support case-insensitivity efficiently, so 
this feature provides an approximate solution.

See also the description of the CaseInsensitive parameter for data 
sources.

Below is an example of the SQL WHERE clause generated when searching 
for an opportunity named New, when InsensitivityFactor is set to 2.

WHERE

((S_OPTY.NAME LIKE ‘ne%’ OR

S_OPTY.NAME LIKE ‘Ne%’OR

S_OPTY.NAME LIKE ‘nE%’OR

S_OPTY.NAME LIKE ‘NE%’)

AND

UPPER(S_OPTY.NAME)=UPPER(‘New’))

The above example shows that all permutations of the first two letters of the 
string ‘New’ are checked. With a higher factor, the number of permutations 
grows exponentially, and performance suffers.

Note: Do not set this parameter to a value higher than 13.

InsUpdAllCols TRUE or FALSE. Ordinarily when the Siebel application generates INSERT or 
UPDATE statements to send to the database, the actual statement contains 
only the columns where data is present or has changed. When there are 
situations where you generate many statements on a particular table, the 
differences in the values being updated may prevent you from using an array 
interface supported by the DBMS.

When this feature is set to TRUE, all columns are present in all INSERT and 
UPDATE statements. This automatically enables two statements issued 
against the same table in the same business component as part of a batch 
operation to use any existing array feature of the DBMS.

Table 17. Data Source Parameters

Name Comment
Version 7.5.3 Siebel Web Client Administration Guide 139



Configuration Parameters

Data Source Parameters
IntegratedSecurity TRUE or FALSE. When TRUE, the Siebel client is prevented from prompting 
the user for a username and password when the user logs in. Facilities 
provided in your existing data server infrastructure determine if the user 
should be allowed to log into the database.

This parameter is set for your server data source. However, it is supported for 
Oracle and Microsoft SQL Server databases only. The default value is FALSE.

For additional information, refer to your third-party documentation. For 
Oracle, refer to the OPS$ and REMOTE_OS_AUTHENT features. For 
Microsoft SQL Server, refer to Integrated Security.

MaxCachedCursors Specifies the maximum number of SQL cursors that can be cached in 
memory for a database connection. The default is 16.

Caching SQL cursors can improve response time and CPU usage because a 
SQL cursor does not have to be prepared each time it is executed. If memory 
usage is not a concern, you may consider increasing the value of this 
parameter.

MaxCachedDataSets Specifies the maximum number of data sets that can be cached in memory 
for a database connection. The default is 16.

A data set is the set of records that has been retrieved by the execution of a 
business component. Data-set caching applies only to those business 
components for which the Cache Data property has been set in Siebel Tools.

Caching data sets for frequently visited business components can improve 
response time and CPU usage. If memory usage is not a concern, you may 
consider increasing the value of this parameter.

MaxConnections Number of connections that can be made to the data source database server.

MaxCursorSize Sets the total number of rows that can be returned in a result set. 
MaxCursorSize is intended for use only with IBM DB2 UDB for OS/390 
and z/OS, and must be set as described in Implementing Siebel eBusiness 
Applications on DB2 UDB for OS/390 and z/OS. If you are using another 
database, do not set this parameter to anything other than the default value 
(-1), or database behavior is adversely affected. MaxCursorSize and 
PrefetchSize are used together, and must be set to the same value. See 
also the description for the PrefetchSize parameter.

NonSQL TRUE or FALSE. Setting that indicates that the data source does not use an 
SQL DBMS to retrieve its data. This would be used only in conjunction with 
a specialized business component that would build internally. It would never 
be arbitrarily set by a Siebel customer.

Table 17. Data Source Parameters

Name Comment
140 Siebel Web Client Administration Guide Version 7.5.3



Configuration Parameters

Data Source Parameters
PrefetchSize Sets the number of rows that the Siebel application reads initially as part of 
a query execution. PrefetchSize is intended for use only with IBM DB2 
UDB for OS/390 and z/OS, and must be set as described in Implementing 
Siebel eBusiness Applications on DB2 UDB for OS/390 and z/OS. If you are 
using another database, do not set this parameter to anything other than the 
default value (-1), or database behavior is adversely affected. 
MaxCursorSize and PrefetchSize are used together, and must be set 
to the same value. See also the description for the MaxCursorSize 
parameter.

PrimaryEnterprise The name of the Enterprise Server you want to administer from the client 
machine. Set this parameter to view or change information in the Server 
Administration screens.

RequestServer If you are not using Resonate Central Dispatch, this is the name of the Siebel 
Server that should service requests from the Siebel client. If you are using 
Resonate Central Dispatch, this parameter should be left blank.

ReverseFillThreshold When the current query contains many rows, it may be very inefficient to 
read sequentially through all of them if the user hits the End button. For this 
reason, the customer may configure a threshold value to invert the current 
sort, re-execute the query, and fill the data buffers from the end. This is 
hidden from the user.

SortCollation Allows the user to specify sorting order on the local database or Sample 
Database.

Note: The SortCollation parameter is not a default part of the 
configuration file, so it must be added manually in order to take effect. If this 
parameter is not present, sorting in Siebel applications when using SQL 
Anywhere uses the binary sort order as identified here. Customers using 
languages other than English (particularly those using accented characters) 
may prefer to use an appropriate setting from the list below.

After this parameter is changed, the Siebel application must be restarted in 
order for the change to take effect.

The valid values of the SortCollation parameter, supported by the SQL 
Anywhere database, consist of the following values:

ISO 14651 Unicode multilingual (Default): default 

ISO 14651 Unicode multilingual ordering standard: 14651 (produces same 
results as default sort collation)

Table 17. Data Source Parameters

Name Comment
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SortCollation 
(continued)

Big5 (Traditional Chinese) binary order: big5bin 

Binary sort: binary (produces UTF-8 binary order)

CP 850 Western European: no accent: altnoacc 

CP 850 Western European: lower case first: altdict 

CP 850 Western European: no case, preference: altnocsp 

CP 850 Scandinavian dictionary: scandict 

CP 850 Scandinavian: no case, preference: scannocp 

CP874 (TIS 620) Royal Thai dictionary order: thaidict 

CP932 (Japanese on Windows) Shift-JIS binary order: sjisbin 

CP932 (Japanese on Windows) Shift-JIS with Microsoft extensions binary 
order: cp932bin 

GB2312 (Simplified Chinese) binary order: gb2312bin 

GB 2312 (Simplified Chinese) Pinyin phonetic order: gbpinyin 

EUC JIS (Japanese on UNIX) binary order: eucjisbin 

EUC KSC (Korean) binary order: euckscbin 

ISO 8859-1 ('Latin-1') English, French, German dictionary order: dict 

ISO 8859-1 ('Latin-1') English, French, German no case: nocase 

ISO 8859-1 ('Latin-1') English, French, German no case, preference: 
nocasep 

ISO 8859-1 ('Latin-1') English, French, German no accent: noaccent 

Table 17. Data Source Parameters
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SortCollation 
(continued)

ISO 8859-1 ('Latin-1') Spanish dictionary: espdict 

ISO 8859-1 ('Latin-1') Spanish no case: espnocs 

ISO 8859-1 ('Latin-1') Spanish no accent: espnoac 

ISO 8859-2 Hungarian dictionary: hundict 

ISO 8859-2 Hungarian no accents: hunnoac 

ISO 8859-2 Hungarian no case: hunnocs 

ISO 8859-5 Cyrillic dictionary: cyrdict 

ISO 8859-5 Cyrillic no case: cyrnocs 

ISO 8859-5 Russian dictionary: rusdict 

ISO 8859-5 Russian no case: rusnocs 

ISO 8859-7 Greek dictionary: elldict 

ISO 8859-9 Turkish dictionary: turdict 

ISO 8859-9 Turkish no accents: turnoac 

ISO 8859-9 Turkish no case: turnocs 

Unicode UTF-8 binary sort: utf8bin (produces same results as binary sort 
collation)

Note: In the values above, no accent indicates that the accented and 
nonaccented characters are treated equivalently by the sort. No case 
indicates that the sort ignores case. Preference indicates that uppercase 
records appear before lowercase records where the letter is the same but the 
case differs.

SqlStyle Indicates what kind of SQL to send to the database you are using. When 
generating SQL to send to a DBMS, the application needs to construct the 
SQL statement to suit the particular DBMS.

The value of this parameter is automatically set by the Siebel client or server 
installer, according to database information you specified.

The local database or Sample Database, based on SQL Anywhere, use 
Watcom. Server databases such as IBM DB2 Universal Database, Microsoft 
SQL Server, or Oracle use the style applicable to the particular DBMS.

Table 17. Data Source Parameters

Name Comment
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The following is a selection of content from the configuration file uagent.cfg, for 
Siebel Call Center. On the left are parameter names, and on the right are sample 
values. Values are initially populated when you install. If you need to change any 
values, edit them according to how you want your system to function. Note that 
lines that start with semi-colons are not in effect or are comments only.

;; At the top of each section, we have listed if the parameters are

;; being read from the cfg file for Server based Object Manager

;; components

;; If the section below says "Client-only" section, then the parameter

;; values listed here will not be read from this cfg file but from 

;; parameters as defined during the configuration for the Siebel Enterprise

;; In effect the parameter values will be read from the gatewaysrvr/shared

;; memory. If you need to change the values for any of these parameters

TableOwner In a database, tables are identified by both their owner and their name. 
When queries that reference tables are issued, the tableowner must be 
included in those references (for example, SIEBEL.S_EVT_ACT, where 
SIEBEL is the tableowner).

For more information on setting this parameter for the local database, see 
“Mobile Web Client Configuration Parameters” on page 79.

UpperCaseLogin The default is FALSE. If set to TRUE, the user ID, when a user logs in, is 
converted to uppercase before it is sent to the database for authentication. 
This value is applicable only if the database is used for authentication; the 
value of the parameter is ignored when SecurityAdapter is set to a non-
empty value.

Use this parameter if you want to enforce a policy of having all database 
accounts in uppercase on a case-sensitive database, but you do not want 
users to worry about case when they type in their user names. 

Note: The value of UpperCaseLogin does not affect the password.

Table 17. Data Source Parameters
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;; please use the Server Admin screens  or servermanager line mode to 

;; change the values. At the top of each section, it also lists where 

;; the parameter values are defined, i.e. are thay component parameters

;; or named subsystem parameters.(This is visible to the complete enterprise.) 

;;

;; For Developers, If you need to change values during configuration

;; for Object Manager components, please change the srvrdefs.tdt file

;;

;; For Users, If you need to change the values after configuration

;; for Object Manager components, go to the relevant Server Admin screen

;; and update parameters.

;; 

;;

;;

;; The following Siebel Section is a client-only section. 

;; It is a part of object manager parameters for the server components

[Siebel]

RepositoryFile           = siebel.srf

ApplicationName          = Siebel Universal Agent

ApplicationTitle         = Siebel Call Center

ApplicationSplashText    = Siebel Call Center

Vertical                 = 

ComponentName            = Siebel Call Center Client

ShowMessageBar           = User Enabled

MessageBarUpdateInterval = 120

DataSource               = Local

ClientRootDir            = d:\sea752\client

TempDir                  = d:\sea752\client\temp

Version                  = 100
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ClientFileServSupport    = TRUE

MultiCurrency            = TRUE

EnableScripting          = TRUE

EnableOLEAutomation      = TRUE

OLEAutomationDLL         = sscfole.dll

EnableCORBA              = FALSE

CORBADLL                 = sscfcorb.dll

JseCorbaConnector        = corbavgn.dll

ReportsODBCDataSource    = Siebel Reports: Access

ServerDbODBCDataSource   = 

DockRepositoryName       = Siebel Repository

LocalDbODBCDataSource    = SEAW Local Db d:/sea752/client

DefaultChartFont         = Verdana-10-normal

Language                 = ENU

SrvrUpdateInterval       = 60

SrvrTimeOutInterval      = 600

EnablePersonalization    = TRUE

PersonalizationLog       =

DocumentIntegrator       = Microsoft Office

WebClientSiteDir         = d:\sea752\client\public\enu

AccessDir                = $(AccessRoot)

SearchEngine             = Fulcrum

SearchDefName            = Call Center Definition

SearchInstallDir         = 

RemoteSearchServer       = True

RemoteSearchServerPath   = CHANGE_ME/tcpCHANGE_ME

EnableFQDN               = FALSE

FQDN                     = CHANGE_ME

; SecurityAdapter        = LDAP
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; UsernameBCField        = 

;; This is a client-only section ( for example siebel.exe)

;; All the data sources shown below are defined as 

;; named subsystems in the Siebel Enterprise. To change the values

;; for these datasources, use the  following command

;; In the line mode srvrmgr

;; > change param paramname="<value>" for named subsystem <named subsys name>

;; In the case below it will be Local/Sample/ServerDataSrc/GatewayDataSrc

[DataSources]

Local                    = Local

Sample                   = Sample

ServerDataSrc            = Server

GatewayDataSrc           = Gateway

[Local]

Docked                   = FALSE

ConnectString            = d:\sea752\client\local\sse_data.dbf  -q -m -x NONE -gp 
4096 -c40m -ch60m

TableOwner               = SIEBEL

DLL                      = SSCDW8.DLL

SqlStyle                 = Watcom

MaxCachedCursors         = 16

MaxCachedDataSets        = 16

ReverseFillThreshold     = 100

CaseInsensitive          = FALSE

InsensitivityFactor      = 2

DockTxnsPerCommit        = 500
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Sample Selection from Configuration File
DockConnString           = FALSE

ChartServer              = localhost:8001

ChartImageFormat         = png

AutoStopDB               = FALSE

EnterpriseServer         = CHANGE_ME

RequestServerName        = CHANGE_ME

UseCachedExternalContent = TRUE

[Sample]

Docked                   = FALSE

ConnectString            = d:\sea752\client\sample\UTF8\sse_samp.dbf -q -m -x NONE 
-gp 4096 -c40m -ch60m

TableOwner               = SIEBEL

DLL                      = SSCDW8.DLL

SqlStyle                 = Watcom

MaxCachedCursors         = 16

MaxCachedDataSets        = 16

ReverseFillThreshold     = 100

CaseInsensitive          = TRUE

InsensitivityFactor      = 2

FileSystem               = d:\sea752\client\sample\files

ChartServer              = localhost:8001

ChartImageFormat         = png

SymbolicURLSuffix        = _Demo

AutoStopDB               = FALSE

[ServerDataSrc]

Docked                   = TRUE

ConnectString            = $(ConnectString)
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TableOwner               = $(TableOwner)

DLL                      = sscddcli.dll

SqlStyle                 = DB2

MaxCachedCursors         = 16

MaxCachedDataSets        = 16

ReverseFillThreshold     = 100

CaseInsensitive          = FALSE

InsensitivityFactor      = 2

FileSystem               = .\CHANGE_ME\att

GatewayAddress           = CHANGE_ME

EnterpriseServer         = CHANGE_ME

RequestComponent         = $(RequestComponent)

RequestServer            = CHANGE_ME

RequestServerName        = CHANGE_ME

CurrentSQLID             = Startup

MaxCursorSize            = -1

PrefetchSize             = -1

ChartServer              = localhost:8001

ChartImageFormat         = png

[GatewayDataSrc]

ConnectString            = CHANGE_ME

PrimaryEnterprise        = CHANGE_ME

DLL                      = sscda10.dll

Hidden                   = TRUE

CaseInsensitive          = FALSE

InsensitivityFactor      = 0
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charts directory 44
client shortcuts 46
ClientRootDir parameter 80
clients

See also Mobile Web Client; Dedicated 
Web Client; Web Client

architecture 15
browser settings for 53
choosing 18
database failure 82
deploying 53
described 17
docked 81
features 18
logical diagram 15
ODBC data sources 45
overview 18
prerequisites 29
Siebel Handheld 17
Siebel Remote 22, 79
Siebel Wireless 17
starting without VB or eScript 

licensed 42
types of 17, 20
verifying directory structure 43
Version 7.5.3 Siebel Web Client Administration Guide 151



Index
Compact setup option 34, 40
configuration

browser settings for Siebel clients 53
Dedicated Web Client 115
Mobile Web Client 79, 115

configuration (CFG) files
directory for 43
editing 113, 117

configuration parameters
alphabetical index 117
DataSources section 134, 135
Local section 80
Mobile Web Client 79
Preload section 93
Siebel applications 128
Siebel section 80, 128

cookies
auto-login credential 75
enabling 77
session 75
Siebel QuickStart 75, 91
Siebel Reports Server 75

csagent.cab file 65
Custom setup option 34, 40

D
database

applying changes 85
connectivity software 30
extraction process 82
failure 82
IBM DB2 Universal Database for OS/390 
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eapps.cfg file 115
eBusiness Applications

See Siebel applications
editing configuration files 113
email, distributing packages using 95, 105
EncryptSessionId parameter (eapps.cfg 

file) 76
Enterprise Server, Siebel 37
erm.cfg file 115
eScript, starting clients without 42

F
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file system
See also Siebel File System
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(CFG) files
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G
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deployment requirements 57
manual browser settings 69
overview 55
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HTTP 1.1 protocol 57
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and z/OS, and Dedicated Web 
Client 31

IBM DB2 Universal Database for Windows 
and UNIX
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Dedicated Web Client and 30, 35
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See shortcuts

IFRAME support 72
Import language, shortcut for 47
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automated uninstallation 51
CD-ROMs 33, 39
database connectivity software 30
Dedicated Web Client 32
directory for 29, 43
failures 33, 35, 39, 82
file system and 35
Mobile Web Client 32
network drives 33, 39
Sample Database 39
space required for 35
third-party software 31
uninstalling Siebel clients 51
verifying 42

installers
creating 101
customized 104
making available 104
siebel.ini file and 105
testing 110

IP addresses 37
isstempl directory 44

J
Java applets 68
Java deployment requirements 66
Java Runtime Environment (JRE), Sun 65, 

68
Java Virtual Machine (JVM), Microsoft 67
JavaScript 57
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language-specific files 43, 44
license key 48
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packages using 95, 105
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directory for 44
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log files 44
logging in
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Siebel applications 48
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Dedicated Web Client and 30, 35
ODBC data sources 45

Mobile Web Client
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through 48
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Version 7.5.3 Siebel Web Client Administration Guide 155



Index
configuration file for 115
Siebel Enterprise Server 37
Siebel eScript, starting clients without 42
Siebel File System

connectivity information 36
and Dedicated Web Client 21
local 22

Siebel Handheld Client 17
Siebel HI Base Framework 65
Siebel Marketing

configuration file for 115
shortcut for 47
shortcut for Demo 47

Siebel Packager utility
See Packager utility

Siebel Partner Manager, configuration file 
for 115

Siebel QuickStart 91
Siebel QuickStart cookie 75, 91
Siebel Remote

client software 22
configuration parameters 79
installation failures 82
local database extraction 49
and Mobile Web Client 22
network connectivity 79
shortcut for 47
starting 47
synchronization options 83, 88
transmission failure 82

Siebel Remote Server
network connectivity to 79
setting up 79
software for 22

Siebel Reports 43
Siebel Reports Server cookie 75
Siebel repository file (SRF) 19, 44
Siebel Rich Text Editor 65
Siebel Sales

configuration file for 115
shortcut for 47
shortcut for Demo 47

Siebel Server 19

Siebel Server Manager, installing 34
Siebel Service

configuration file for 115
shortcut for 47
shortcut for Demo 47

Siebel Systems Uninstallation Manager 51
Siebel VB, starting clients without 42
Siebel Web Client

See Web Client
Siebel Web Client Automation Server 65
Siebel Web Server Extension 115
Siebel Wireless Client 17
siebel.cfg file 115
siebel.exe program 50
siebel.ini file 105
siebel.local.client cookie

See Siebel QuickStart cookie
SIEBEL_CLIENT_ROOT directory 29, 43
SiebelFlowChart.cab file 68
SiebelFunnelChart.cab file 68
siebelhtml.cab file 65
siebelhtmlEditorLaunch.cab file 65
SiebelLocale.cab file 68
SiebelMarketingEditor.cab file 68
SiebelMenu.cab file 68
SiebelOptionPack.cab file 10, 65
SiebelRulesDesigner.cab file 68
SiebelShared.cab file 69
SiebelToolbar.cab file 69
SiebExtMailClient.cab file 66
siebunis.bat file 51
software

browsers 53
database connectivity 30
DB2 client software 30
third-party 31

software packaging
See Packager utility

SQL Anywhere database 82
sqltemp directory 44
SRF (Siebel repository file) 19, 44
standard interactivity

deployment requirements 57
156 Siebel Web Client Administration Guide Version 7.5.3



Index
overview 55
startup options, for Mobile and Dedicated 

Web Client 50
subman.cab file 66
Sun Java Runtime Environment (JRE) 65, 

68
synchronization

background 22
options 83, 88
stand-alone 22, 47, 82, 83

T
TableOwner parameter 82
TCP/IP protocol 19, 22, 79
temp directory 44
templates, security settings for Microsoft 

Internet Explorer 58
thin clients

See clients
transaction log 22
troubleshooting

database failure 82
installation failures 33, 35, 39, 82
transmission failure 82

Trusted sites zone 58
Typical setup option 34, 40

U
uagent.cfg file 115, 144
uninstalling Siebel clients 51
upgrade directory 44
user synchronization options 83, 88
Users group 61

V
VB, Siebel VB, starting clients without 42
virtual IP (VIP) 37
virtual private networks (VPNs), 

distributing packages using 95, 105

W
Web browsers

See browsers
Web Client

See also clients
and Application Object Manager 19
deploying 53
described 17, 18
features 18

Web Client Automation Server 65
Web content zones 58
webtempl directory 44
wide area networks (WANs), distributing 

packages using 95, 105
Wireless Client, Siebel 17
Version 7.5.3 Siebel Web Client Administration Guide 157



Index
158 Siebel Web Client Administration Guide Version 7.5.3


	Contents
	Introduction
	Product Modules and Options
	How This Guide Is Organized
	Additional Resources
	Revision History
	Version 7.5.3
	January 2003 Bookshelf


	About Siebel Clients
	Siebel Client Types
	Siebel Web Client
	Siebel Mobile and Dedicated Web Clients
	Siebel Mobile Web Client and Siebel Remote
	Configuring the Siebel Application
	Application Names and Siebel Clients
	User Preferences and Siebel Clients
	Locale Settings for Siebel Clients

	Installing Mobile and Dedicated Web Clients
	Before Installing
	Installing the Siebel Mobile and Dedicated Web Client
	Installing the Sample Database
	After Installing
	Logging into Your Siebel Application
	Siebel Mobile and Dedicated Web Client Startup Options
	Uninstalling the Mobile and Dedicated Web Clients

	Deploying Siebel Web Clients
	About Deployment Modes for Siebel Web Clients
	Standard Interactivity
	High Interactivity
	Overview of Deployment Requirements

	Standard Interactivity Deployment Requirements
	High Interactivity Deployment—General Requirements
	High Interactivity Deployment—ActiveX Requirements
	Modifying User Groups or Permissions
	Predeploying ActiveX Controls for Secure Environments
	ActiveX Controls Distributed for High Interactivity
	Uninstalling ActiveX Controls

	High Interactivity Deployment—Java Requirements
	Specifying the Java Software Environment
	Java Applets Distributed for High Interactivity

	Manual Security Settings for High Interactivity
	Manual Settings for ActiveX Controls and Plugins
	Manual Settings for Scripting
	Manual Settings for Downloads
	Manual Settings for Microsoft Java Virtual Machine
	Manual Settings for IFRAME Support

	Other Deployment Options for High Interactivity
	Using Secure Sockets Layer (SSL)
	Deploying Siebel Applications Accessed Through a Firewall
	Disabling Script Debugging

	Using Cookies with Siebel Applications
	Session Cookie
	Auto-Login Credential Cookie
	Enabling Cookies for Siebel Applications


	Configuring and Using Mobile Web Client
	Troubleshooting Mobile Web Client and Siebel Remote
	User Synchronization Options for Mobile Web Client
	Siebel Mobile Web Client and Siebel QuickStart

	Using Siebel Packager Utility
	Preparing to Use the Siebel Packager Utility
	Siebel Modules for Packaging
	Running the Siebel Packager Utility
	Making Your Customized Installer Available to End Users
	Customizing Siebel.ini Files
	Key Parameters in Siebel.ini File
	Major Sections of the Siebel.ini File
	Siebel.ini File Hierarchy and Organization
	Testing an Installer After Customizing the Siebel.ini File


	Configuration Parameters
	Editing Configuration Files
	Configuration Parameters Index
	Siebel Application Parameters for Client
	Data Source Parameters
	Sample Selection from Configuration File

	Index

